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Getting Started

Getting Started with Concepts

Concepts is a flexible tool for sketching, note-taking, and design. Imagine traditional

paper upgraded to an infinite canvas where every stroke is adjustable. This allows you to

fully explore, communicate, and develop your ideas. Concepts is optimized for touch and

stylus devices and is available on iOS, Android, Windows, and ChromeOS.

Watch our Start Creating with Concepts in Only Ten Minutes video or read through the

Quick Start Guide below.

Quick Start Guide
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1. When you first open Concepts, you are taken to the Gallery, where you can

view, manage and organize your drawings.

2. Tap the + button at the bottom of the screen to start a new drawing.

3. When you start a new drawing, you're taken to the Infinite Canvas.

4. At the top of the screen, you'll find your Status Bar.

5. In your Status Bar, you'll find several important options:

a. Return to Gallery button

b. Drawing name (tap it to rename your drawing)

c. Toggle Precision (shows/hides Precision menu)

d. Toggle Layers (shows/hides Layers menu)

e. Toggle Objects (shows/hides Objects menu)
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f. Zoom and rotation options

g. Pro Store, to get what you need

h. Import

i. Export

j. Settings

k. Help

Canvas Gestures

6. Concepts is optimized for touch-based devices. To move or pan the Infinite

Canvas, place two fingers on the canvas and drag them around.
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7. To zoom in and out, try pinching and spreading your fingers.
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8. You can rotate your canvas by placing two fingers on the screen and

turning your hand.
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9. The most important menu on your canvas is the Tool Wheel. You can have

up to eight configurable tool slots, along with Undo and Redo buttons, plus

property sliders and the color menu.
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10. To select a tool, tap on one of the tools on the outer rim of your Tool Wheel.

If you tap a selected tool again, you can access the brush menu, where you

can find all the brushes and tool options.
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11. The middle ring of the Tool Wheel has adjustment sliders for your brush

size, opacity and smoothing. You can easily make adjustments to your tool

by tapping on one of the symbols, or just by dragging. If you want to draw

straight lines, try setting your smoothing to 100%.
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12. In the Tool Wheel, there's also buttons for Undo and Redo. You can also

use the default gesture of tapping with two fingers to Undo and tapping

with three fingers to Redo.
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13. The center of the Tool Wheel displays your current active color. Tap the

center to bring up the Color Wheel. You can choose between COPIC, HSL

and RGB color wheels. You can also select colors from anywhere on the

canvas, such as an image, by using the Color Picker. Tap on the picker icon

or use the Tap+Hold gesture on canvas.

You can toggle several canvas items on or off depending on your needs.
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14. Tap the Precision Icon in the status bar to bring up the Precision Menu. In

the Precision Menu, you have controls for Grid, Snap, Measurement and

Shape Guides. Toggle the box to turn the feature on or off. Tap the opposite

side to bring up configuration options for each.

15. Tap the Layers Icon to bring up the Layers Menu. You might be familiar

with Manual Layering already, but one place where Concepts stands apart

is an Automatic layering mode that sorts your strokes by tool type while

you draw. You can toggle between the two modes by tapping the sorting

button. Manually adjusting or selecting a different layer will automatically

switch you from Automatic sorting into Manual mode.
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In Manual mode, tap any layer to activate it, or tap again to bring up options

like select, delete, merge and opacity.

16. Tap the Objects Icon to bring up the Objects Library. Objects are pre-made

assets that can significantly speed up your design work. You can find a

library full of royalty-free Objects in the Object Market. You can also Make

Your Own Objects. Choose a pack and drag the Objects directly to canvas.
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17. The Tool Wheel, Precision Menu, Layers Menu and Objects Library

are moveable canvas elements. You can customize the canvas to make it

more suitable to your workflow. You can relocate the canvas elements by

long-pressing, dragging, and dropping them on the canvas.

In the Status Bar you will find some more useful features to try out.
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18. To add images to your canvas, tap the Import Icon in the Status Bar to open

the Import menu.

19. When you are ready to share your drawing with your teammates or clients,

tap the Export Icon in the Status Bar. You can export in various formats,

sizes and resolutions to your photo library, the Files app, various cloud

drives, messaging apps, and more.
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20. You can find your Workspace and Interactions Settings by tapping the

Settings icon in the Status Bar.
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21. In the Workspace tab, you can make adjustments to your canvas by

changing the background, grid type, artboard size and measurement

settings.
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22. The Interactions tab allows you to configure options specific to your input

preferences. Concepts is optimized to be used with a stylus. If you don't

have one, we highly recommend it for its natural feel and shortcut options.

You can set your stylus to draw and your finger to pan. Other gesture

options are available for things like the two-finger tap to Undo or three-
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finger tap to Redo.

One of the most useful gestures in Concepts is the Tap+Hold. You can use

this on canvas as a color picker, or by default as a selection tool. As

Concepts is based on a vector drawing engine, every single stroke can be

picked up and moved around, duplicated and adjusted.

23. If you ever get stuck, tap the question mark to access the Help menu. In the

help menu, you'll find our latest news at the top, this manual, which you can

open in the app and follow along with. You can also find links to our social

media and Ask Us Anything, which you can tap to chat with our team.

You should now know enough about the Concepts interface to start exploring the Infinite

Canvas and your ideas. If you're new to sketching, be sure to check out our free Learn to

Draw Series on YouTube to get better at drawing and visualizing your ideas.

To learn more about Concepts, please choose a category from the sidebar or dropdown

menu. Each section starts with a short summary to help you get started quickly. You can

also read the full manual as a PDF.

Concepts is always evolving. We update frequently, adding new features and

improvements based largely on your feedback. If you have suggestions, let us know.

Sign up for the free trial to get the most out of Concepts!
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Stay Connected & Get Support

Stay Up-to-Date

Sign up for our newsletter to receive the latest news and feature releases.

Get Help

Check out our Help page in-app for how-tos and expert interviews.

Explore our video tutorials and workflow videos on YouTube.

Join our Discord Community to connect with other creators, chat with the Concepts team,

find inspiration and stay up to date on all things Concepts.

For direct assistance, email us at support@concepts.app or tap Help > Ask Us Anything

in the app to chat with our team.

Want to Use Concepts with Your Team?

If you're looking for more information about using Concepts with your team, navigate to

our dedicated Concepts for Business page here.

https://concepts.app/newsletter
https://concepts.app/newsletter
https://www.youtube.com/conceptsapp
https://concepts.app/discord
https://concepts.app/discord
mailto:support@concepts.app
https://concepts.app/en/teams
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The Gallery

The Gallery

QUICK SUMMARY

1. All your drawings can be viewed, managed and organized in folders in the Gallery

2. Tap the + New Drawing to create a new drawing in the current folder

3. Tap+hold on the drawing thumbnail to duplicate, rename or delete your drawing

The first time you open Concepts, you'll start in the Gallery. This is where all of your

drawings are stored and organized into folders. You can create new drawings, open

existing drawings, import images, PDFs and more.
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Interface

Concepts Gallery

1. Start Something New. Start a new drawing, create a new folder, import from

Files or Photos, paste from the clipboard, or take a quick picture for later

markup.

2. Sidebar Toggle. Tap this to hide or show the sidebar. The button shows the

name of your current folder.

3. Pro Store. Shows your purchase status and all three available plans:

Everything Subscription, Essentials, and Free.

4. Account. Create an account or sign in to an existing account.
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5. Help. Tap to access the Manual and other learning material. If you

encounter a problem or get stuck, contact us via Ask Us Anything.

6. Sidebar. The sidebar can be collapsed or remain on screen. It shows all of

your top-level folders in a single place for easy navigation. Tap a folder to

access it. Tap New folder to create a new one. Under "Extras", you can find

your Recently Deleted drawings.

7. Navigate Back. Tap here to navigate back to the parent, or top-level folder.

8. Folder name. Tap to rename.

9. Notes. Add notes about your project here.

10. Grouping. Keep your work organized the way you like. Group by Date

Created, Date Updated, Folder, or None.

11. Sorting. Sort the contents of your folders by Name, Date Created, or Date

Updated.

12. Drawing. Tap to open. Tap+hold to duplicate, rename or delete your

drawing.

13. Subfolder. Create as many subfolders as you like in your main folders to

organize your drawings.

14. New Drawing. A shortcut for quickly creating and opening a new, empty

drawing.

15. Start Something New. Start a new drawing, create a new folder, import from

Files or Photos, paste from the clipboard, or take a quick picture for later

markup.

Gallery Interactions
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Tap or click on drawings and folders to open them.

Tap+hold or right-click to rename, duplicate or delete drawings and folders.

On iOS and Android, drawings will also show a Share option.

Drag & Drop to move drawings between folders or to other apps. You can

drop into folders in both the Gallery and Sidebar views.
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Scroll to search through your drawings in the Gallery view. You can scroll

the Sidebar to scan your top-level folders.

Zoom in and out in your drawings with a two-finger pinch or spread. (Only

on iOS and Android)

Creating Drawings

There are several ways to create drawings in the Concepts Gallery.
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1. Tap the + New Drawing button to create a new drawing.

2. Tap on either the + in the top left corner or the arrow next to the + New

Drawing button to see more options for creating a drawing.
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3. In the pop-up that appears, you have several options for drawing creation.

Tap Photos if you want to create a drawing based on an imported photo

from your device's photos.

4. Create a new drawing based on an imported file, or import an existing

Concepts file.

5. Create a new drawing with the items currently copied to your clipboard.

6. Take a Picture with your device to create a new drawing.

7. Tap Recently Imported to see images and files you have previously

imported.

8. Create a new, empty drawing.
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9. After creating, you will be taken directly to your new drawing. After

returning to the Gallery, you will see a thumbnail of your drawing.

10. Tap+hold on the drawing thumbnail to open a contextual menu for more

options.
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11. Tap Rename to rename your drawing.

12. Tap Duplicate to make a copy of your drawing.

13. Share your drawing file via email or other supported methods.

14. You can also Delete your drawing. Deleted drawings will be moved to the

Recently Deleted section of the Gallery.

Creating Folders

To add structure to your Gallery, you can create as many folders and subfolders as you

need.
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1. Tap on the + in the top left corner or the arrow next to the + New Drawing

button to open the menu for more options.
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2. Tap the New Folder button.
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3. Your newly created folder will show in the Gallery with a thumbnail depicting

its content. Tap on the folder to open it.
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4. You can add new drawings in your new folder as you would anywhere in

the Gallery. Tap on the folder name to rename it.

5. You can add a description to your folder.

6. You can navigate back to your top-level folder by tapping the button above

your folder's name.
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File Management on iOS, Windows, Android

File Management on iOS

On iOS, Concepts has a dedicated Concepts folder in the Files App, under the location

On This iPad/iPhone. This is where all of your work is stored, and the Gallery inside the

app directly reflects the contents of this folder. Feel free to reorganize your work through

the Files App or the Concepts Gallery. Any updates you make to your drawings or folder

details in Concepts will also update them in Files, and vice versa.

Moving your files away from the Concepts folder will remove them from the Concepts

Gallery. That does not mean they do not exist; it just means you have moved them

somewhere that Concepts cannot locate. You can always open a .concept file on a

device where Concepts is installed, even if it is not in the Concepts folder.
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You can also open Concepts drawings from elsewhere in the Files app. If a drawing is

stored outside the Concepts folder in the Files app, it will not appear in your Concepts

Gallery, but it will still be available to edit in Concepts. Tap on any .concept file in the

Files app, and it will open in Concepts. When you exit to the Gallery, the changes will be

saved to the original file you opened, though the file will not appear in the Concepts

Gallery unless the file is moved back into the Concepts folder. You can still access the

drawing from Files.

You can easily create backups of your drawings by copying them in Files and pasting

them into a folder in iCloud or another storage location.

Please note that on iOS, deleting the app from your device also deletes the Concepts

folder in Files and all of its content from your device. If you have a problem with your

app or drawings, reach out to our team first -- tap Help → Ask Us Anything in-app to

reach us, or send a support email to support@concepts.app. We do everything possible

to keep your work safe, but we also advise you to back up your devices regularly. To

learn more about backing up your drawings, please read our article on creating backups.

mailto:support@concepts.app
https://concepts.app/en/tutorials/backing-your-drawings-icloud/
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File Management on Windows

In Windows, Concepts has a dedicated Concepts folder in File Explorer. You will see this

in your Concepts Gallery under the location This Device. This is where all of your work is

stored, and the Gallery inside the Concepts app directly reflects the contents of this

folder. Feel free to reorganize your work through File Explorer or the Concepts Gallery.

Any updates you make to your drawings or folder details in Concepts will also update

them in File Explorer, and vice versa.

Moving your files away from the Concepts folder will remove them from the Concepts

Gallery. That does not mean they do not exist; it simply means you have moved them

somewhere that Concepts cannot locate. You can always open a .concepts file on a

device where Concepts is installed, even if it is not in the Concepts folder. You can also

find your recently used files in the Recently Opened section in the gallery sidebar.

On Windows, deleting the app from your device does not delete the Concepts folder

in File Explorer. If you have to delete and reinstall Concepts, your drawings can still be

found in File Explorer. In any case, we recommend backing up your files if you have to

reinstall Concepts. You can easily create backups of your drawings by copying them in

File Explorer and pasting them into a folder in OneDrive or another storage location.

If you have a problem with your app or drawings, reach out to our team first - tap Help →

Ask Us Anything in-app to reach us, or send a support email to support@concepts.app.

We do everything possible to keep your work safe, but we also advise you to back up

your devices regularly. To learn more about backing up your drawings, please read our

article on creating backups.

mailto:support@concepts.app
https://tophatch.helpshift.com/hc/en/3-concepts/faq/202-how-do-i-back-up-my-drawings-1647897027/
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Changing Gallery Location (Windows only)

You can find and change your Concepts folder location by tapping the settings button in

the gallery under Gallery folder location.

File Management on Android

On Android, your drawings are stored by default in App Storage. Please note that on

Android, deleting the app from your device also deletes all the content in App Storage.
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You can also grant Concepts access to your device's Internal Storage.

In the Gallery Sidebar, under Internal Storage, tap Enable Permissions and toggle the

button in device settings. This will create a folder on your Android device which you can

access directly from your File Manager app. You can reorganize your Internal Storage

drawings in either the File Manager or the Concepts Gallery. If you move your files away

from the Concepts folder, they will also be removed from the Concepts Gallery. That

does not mean they do not exist; it simply means you have moved them somewhere that

Concepts cannot locate.

Deleting Concepts will not remove the files in Internal Storage. If you have a problem

with your app or drawings, reach out to our team first. Tap Help → Ask Us Anything in-

app to reach us, or send a support email to support@concepts.app. We do everything

possible to keep your work safe, but we also advise you to back up your devices

regularly. To learn more about backing up your drawings, please read our article on

creating backups.

mailto:support@concepts.app
https://concepts.app/faq-result?f=183-how-do-i-back-up-my-drawings-1608221978&s=general&p=android&l=en
https://concepts.app/faq-result?f=183-how-do-i-back-up-my-drawings-1608221978&s=general&p=android&l=en
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Backing up your Drawings on Android

You can easily create backups of your drawings by copying them in your File Manager

and pasting them into a folder in Google Drive or another storage location. You can also

enable Google Drive backup in the settings to automatically back up your files. Please

note that this cannot be used for syncing drawings between devices.

Drawing Sync

You can sync your drawings between your different devices by using iCloud (on iOS) or

other third-party software (Windows and Android).
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Drawing Sync on iOS

On the sidebar of your Gallery, there is a separate location for syncing your drawings –

iCloud.

All of your drawings under this location will be automatically synced across your

devices that are signed in to the same Apple ID, where you can view and edit drawings

as usual.

To sync existing drawings or folders from your device, simply drag and drop them under

iCloud. After a short wait, you'll see them appear on your other device. Whenever you

want to switch devices, just sign in to your Apple ID as usual, install Concepts, and all

your synced drawings will be there, backed up and ready to go.

Drawing Sync on Windows

At the moment, there's no way to sync Concepts files natively across Windows devices,

but you can use third-party software to synchronize folders on multiple devices.

On both of your devices, install and set up your cloud storage app for desktop. Use the

same account for both devices and create a folder in your cloud service where you

want to store your Concepts Gallery.

Open Concepts and navigate to the Gallery. Open up your settings and choose Change

from your Gallery folder location. Navigate to the correct location on your Cloud

Storage App with the File Explorer. Repeat this process for both of your devices and

you're good to go! Please note that drawings created with newer versions of Concepts

will not open on older versions.

Read a more detailed guide in our file sync tutorial here.

Drawing Sync on Android

At the moment, there's no way to sync Concepts files natively across Android devices,

but you can use third-party software to synchronize folders on multiple devices.
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On both of your devices, enable Concepts the permission to use your internal storage.

On both of your devices, install and set up a cloud storage app. Depending on your

storage app, you might also need separate software for syncing. Use the same

account for both devices and choose your Concepts internal storage folder to be

synced.

Read a more detailed guide in our file sync tutorial here.
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Accounts

Accounts

QUICK SUMMARY

1. Tap the Accounts icon to create a free Concepts account and sync your

subscription across your devices.

2. Use email, Google Sign In or Apple Sign In to create an account.

3. Let us know what you use Concepts for by filling out the Interests Survey

so we can develop Concepts to be even better.

You can create a free Concepts Account to securely sync your subscription purchases

between your devices. On iOS, the Account also syncs your workspace preferences,

brush and Object libraries, and color palettes between your iOS devices. Concepts

accounts do not sync your drawings between devices. For drawing sync, refer to the

Drawing Sync section.

Interface

Account Screen

After creating your free Concepts Account, your account page will look something like

this.
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1. Account icon. Tap the Account icon to open accounts.

2. Close. Close the Account menu by tapping the "x" button.

3. Interests Survey. If you have not filled out the survey yet, you'll see a

banner prompting you to fill a short survey. This helps us better understand
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your needs.

4. Sign Out. To sign out of your account, tap the Sign Out button. Please note

that any brushes, Objects and palettes you have synced to your account

will not be available if you are signed out.

5. Sync Status. This shows your account sync status.

Green. Everything has synced successfully.

Yellow. Syncing is in progress.

Red. Something went wrong. You should see an error message. You can

contact our support team through the Help menu in the app.

6. Name. You can change your name at any time.

7. Email. You can change your email. You will receive a new confirmation email

to confirm the change.

8. Email verified. This shows the status of your email verification.

9. Change Password. You can change your account password here.

10. Apple Sign In. You can connect Sign In with Apple to your account. If you

created your account with Apple Sign In, it should already be connected.

11. Google Sign In. You can connect Google Sign In to your account. If you

created your account with Google Sign In, it should already be connected.

12. Interests Survey. You can fill in the Interests Survey here. If you have

already filled out the survey, you can change your answers here.

13. Newsletter sign-up. You can sign up for our newsletter by toggling this

switch. You will receive tips and tricks, interviews, and other learning

material.

14. Beta Testing. If you are interested in beta testing Concepts, toggle this

switch and we will contact you with more details.

15. Manage Purchases. Tap here to manage your purchase settings.



Concepts Manual Accounts

49

16. Delete Account. If you want, you can delete your Concepts account. Please

note that this action cannot be undone. You will also lose any Brushes,

Objects, and Palettes that you have synced through your account if you

decide to delete it. Your drawings will not be affected.

17. Terms of Service. Read Concepts' Terms of Service.

18. Privacy Policy. Read Concepts' Privacy Policy.

Creating a Concepts Account with an email

1. Start by tapping the Account icon in the Status Bar in the Gallery. On

Windows and Android, accounts are also available through the Canvas.

https://concepts.app/en/termsofservice
https://concepts.app/en/privacy
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2. Type the email address you want to use for your Concepts account. Learn

more about how to create your Concepts account with Google Sign In or

Apple Sign In.

3. Once you have typed in your email address, tap Next.
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4. By creating an account, you agree to Concepts' Terms of Service.

5. By creating an account, you agree to Concepts' Privacy Policy.

6. Choose a strong password for your account.

https://concepts.app/termsofservice
https://concepts.app/privacy
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7. Once you have chosen a password, tap Next.

8. Choose a name to use with your account.

9. You can sign up for Concepts' newsletter by toggling this switch. We will

send you useful tips and tricks, interviews, and other learning material.
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10. If you are interested in beta testing Concepts, toggle this switch and we will

contact you with more details.

11. When you're happy with your settings, tap Next.
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12. You will receive an email to confirm your account. This might take a few

minutes.

13. If you do not see the confirmation email, you can resend the email by

tapping the link.

14. Complete a survey to help us better understand your needs. Your

information is private and will only be used to improve your app experience.

15. You can also skip the survey and complete it later.

16. You should receive a confirmation email. Tap the "Click here to activate

your account" link to activate your account.
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17. Once you have confirmed your account, you will see the Account

Confirmed page. Return to Concepts to view your account status.
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18. After confirming your account, your account page will look something like

this.

19. If you have not yet completed the interests survey, you can easily access it

by tapping the top banner or the Take the Survey link in the Interests

section.

20. To sign out of your account, simply tap the Sign Out button. Please note

that any brushes, Objects and palettes you have synced to your account

will not be available if you are signed out.

21. Under Sync Status, you will see if your subscription status, brushes,

Objects, preferences and palettes have been successfully synced.

A green icon indicates that everything has been successfully synced.

If you see a yellow icon, it most likely means that you have not

confirmed your account.

If you see a red icon, it means that something went wrong.

22. Under Notifications, you can adjust your notification settings. If you want to

receive tips and tricks, interviews, and other learning material, you can

choose to join our Concepts newsletter. You can also let us know if you

would be interested in beta testing Concepts.

23. If you wish, you can also delete your Concepts account. Please note that

this action cannot be undone. You will also lose any brushes, Objects and

palettes that you have synced through your account if you decide to delete

it. Your drawings will not be affected.
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Creating a Concepts Account with Apple Sign In

1. Start by tapping the Account icon in the Status Bar in the Gallery. On

Windows and Android, accounts are also available through the Canvas.
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2. Tap the Apple icon to create your account with Apple Sign In.

3. By creating an account, you agree to Concepts' Terms of Service.

4. By creating an account, you agree to Concepts' Privacy Policy.

https://concepts.app/termsofservice
https://concepts.app/privacy
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5. Sign in to your Apple account.

6. Enter your password and tap the next arrow.
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7. Choose a name to use with your account.

8. With Apple Sign In, you can choose to hide your email address. Emails from

Concepts are forwarded to your email.
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9. Once you have chosen your preference, tap Continue to proceed to the

next step.



Concepts Manual Accounts

62

10. If you have chosen to hide your email address, you will see a generated

email address string. If you have chosen to share your email address, you

will see your email address. Either way, our emails will reach you.

11. You can change the name you use.

12. You can sign up for Concepts' newsletter by toggling this switch. We will

send you useful tips and tricks, interviews, and other learning material.

13. If you are interested in beta testing Concepts, toggle this switch and we will

contact you with more details.

14. When you're happy with your settings, tap Next.
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15. Complete a survey to help us better understand your needs. Your

information is private and will only be used to improve your app experience.

16. You can also skip the survey and complete it later.
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17. After creating your account, your account page will look something like this.

18. If you have not yet completed the interests survey, you can easily access it

by tapping the top banner, or the Take the Survey link in the Interests

Survey section.
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19. To sign out of your account, simply tap the Sign Out button. Please note

that any brushes, Objects, and palettes you have synced to your account

will not be available if you are signed out.

20. Under Sync Status, you will see if your subscription status, brushes,

Objects, preferences and palettes have been successfully synced.

A green icon indicates that everything has been successfully synced.

If you see a yellow icon, it most likely means that you have not

confirmed your account.

If you see a red icon, it means that something went wrong.

21. Under Notifications you can adjust your notification settings. If you want to

receive tips and tricks, interviews, and other learning material, you can

choose to join our Concepts newsletter. You can also let us know if you

would be interested in beta testing Concepts.

22. If you wish, you can also delete your Concepts account. Please note that

this action cannot be undone. You will also lose any brushes, Objects and

palettes that you have synced through your account if you decide to delete

it. Your drawings will not be affected.
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Creating a Concepts Account with Google Sign In

1. Start by tapping the Account icon in the Status Bar in the Gallery. On

Windows and Android, accounts are also available through the canvas.
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2. Tap the Google icon to create your account with Google Sign In.

3. By creating an account, you agree to Concepts' Terms of Service.

4. By creating an account, you agree to Concepts' Privacy Policy.

https://concepts.app/termsofservice
https://concepts.app/privacy
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5. Tap Continue to proceed with the sign-up process.
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6. Use your Google Sign In credentials.

7. Once you are done, tap Next.
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8. Once you are signed in to your account, tap Continue.
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9. Make sure your email address is correct.

10. Choose a name to use with your account.

11. You can sign up for Concepts' newsletter by toggling this switch. We will

send you useful tips and tricks, interviews, and other learning material.

12. If you are interested in beta testing Concepts, toggle this switch and we will

contact you with more details.

13. When you're happy with your settings, tap Next.
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14. You will receive an email to confirm your account. This might take a few

minutes.

15. If you don't see the confirmation email, you can resend the email by tapping

the link.
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16. Complete a survey to help us better understand your needs. Your

information is private and will only be used to improve your app experience.

17. You can also skip the survey and complete it later.

18. You should receive a confirmation email. Tap the Click here to activate

your account. link to activate your account.

19. Once you have confirmed your account, you will see the Account

Confirmed page. Return to Concepts to view your account status.
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20. After confirming your account, your account page will look something like

this.

21. If you have not completed the interests survey yet, you can easily access it

by tapping the top banner or the Take the Survey link in the Interests

Survey section.
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22. To sign out of your account, simply tap the Sign Out button. Please note

that any brushes, Objects and palettes you have synced to your account

will not be available if signed out.

23. Under Sync Status, you will see if your subscription status, brushes,

Objects, preferences and palettes have been successfully synced.

A green icon indicates that everything has been successfully synced.

If you see a yellow icon, it most likely means that you have not

confirmed your account.

If you see a red icon, it means that something went wrong.

24. Under Notifications, you can adjust your notification settings. If you want to

receive tips and tricks, interviews, and other learning materials, you can

choose to join our Concepts newsletter. You can also let us know if you

would be interested in Beta Testing Concepts.

25. If you wish, you can also delete your Concepts account. Please note that

this action cannot be undone. You will also lose any brushes, Objects and

palettes that you have synced through your account if you decide to delete

it. Your drawings will not be affected.

Interests Survey

To better understand your needs, we have added an Interests Survey on the account

page. The survey includes a few questions about your Concepts usage as well as how

you found the app.

The survey data is only used for internal purposes to develop features and improve our

content.
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1. To access the Interests Survey, go to your account page. If you have not

completed the survey yet, you should see a banner at the top of the

account page.

2. You can also tap the Take the Survey link further down on the page. If you

have already completed the survey you'll see a Edit your answers link
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instead.

3. Completing the survey helps us develop Concepts based on your needs.

4. You can skip the survey and return to it later.
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5. Your information is private. The data is only used for internal purposes to

develop Concepts.

6. Complete the survey.

7. Tap Submit to submit your answers. You can always edit your answers

later.
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Your Workspace

Your Workspace

QUICK SUMMARY

1. Set up your favourite tools in the Tool Wheel.

2. Customize your canvas by rearranging the Canvas Elements to your liking.

3. You can always get back to the Gallery by tapping the gallery icon in the top

left of the Status Bar.

Interface
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1. The Status Bar. From left to right: Gallery, Drawing Name, Menu Toggles

(tap to add or remove menus from the canvas), Measurements (Zoom &

Angle), Pro Store, Import, Export, Settings, Help. On Windows there are a

few additional items: a Drop-down menu, Account Icon, Full-Screen toggle

and minimize, Windows and close buttons.

2. The Tool Wheel. Eight configurable tools, along with undo and redo. You

can drag & drop it on the side (iOS) or in the middle (Windows & Android) of

the canvas to change it into a Tool Bar. You can also change between the

Wheel and Bar in the Settings.

3. Color Palette & Mixer (iOS Only). A configurable on-canvas palette. Swipe

to scroll through your active palettes (set these up in the Colors Menu).

Tap+hold to mix the palette colors into a gradient selection. Read more

about Colors.

4. Layers. Layers help organize your drawing. For example, you can organize

by tool, iteration, or background/outline. Toggle between Automatic (tool-

based) or Manual (custom) modes. Read more about Layers.

5. Precision Tools. Activate Grids, Snap, Measure, and Shape Guides in this

menu to help you draw precisely. Read more about Precision Tools.

6. Objects. Tap to open the Object Library. Choose objects from the Object

Market or My Object libraries. Read more about Objects.

The Title Bar (Windows Only)

The Title Bar is unique to Concepts for Windows. The Title Bar has several familiar

buttons from the Windows operating system as well as some unique to Concepts.

1. Drop-down Menu. From here, you can save your work and open a new

drawing, open an existing drawing, save your work, export a drawing,
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manage your settings, learn about Concepts, purchase in-app features, find

24-hour Ask Us Anything support and exit the app.

2. Start a New Drawing tap +. Save your current drawing and start a new

drawing by tapping or clicking on the +.

3. Account. Sign up or sign in to your free Concepts account.

4. Pro Store.

5. Full Screen. Enter full screen for fewer distractions. Full-screen mode will

hide the title bar as well as the Windows Taskbar at the bottom.

6. Minimize the app to wait in your Windows Taskbar.

7. Full Screen vs. Window Mode. Shrink your canvas and show your

workspace, or expand to a full display.

8. Quit. Tap X to quit Concepts.

The Status Bar

At the top of the screen, you'll find your Status Bar. Here, you'll find many of the

important tools to get the most out of Concepts.

1. The Gallery. Tap to return to the Gallery.

2. Drawing Name. This displays the name of your current drawing. Tap the

name to rename the drawing.

3. Precision Toggle. This button toggles the Precision menu on the canvas.

You can make it visible or hide it, depending on your needs.

4. Layers Toggle. This button toggles the Layers on the canvas. You can make

layers visible or hide them, depending on your needs.



Concepts Manual Your Workspace

82

5. Objects Toggle. This button toggles the Objects menu on canvas.

6. Canvas Status and Measurements. This shows the current canvas zoom

and rotation; if there's an active selection, its measurements will appear

here. Tap the values to open a measurement popup with more controls, or

tap+hold the values to inline edit them.

7. Pro Store. Tap here to open the store. The button represents the status of

your purchases: PRO when you have purchased either an Everything

subscription or Essentials, and will say Go PRO when you haven't made a

purchase. You can also restore purchases here. On Windows, you can get

to the Pro Store from the Title Bar.

8. Import. Tap this button to access Import options.

9. Export. Tap this button to open the Export menu.

10. Settings. The Workspace tab offers drawing-specific settings like

Background Type, Artboard Size, Units and Scale. Tap the Interaction tab to

configure your gesture and styli preferences.

11. Help. Access our in-app support via Ask Us Anything, and find links to our

latest stories, video tutorials, FAQ, and more.

The Tool Wheel / Bar

Below the Status Bar is the Tool Wheel. This is where you access your tools, configure

their properties and choose your colors.
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Tools

The outer ring has up to eight configurable tool slots. Tap a tool to activate it and start

drawing. Tap again (or double-tap an inactive tool) to enter the Brush menu, where you

can choose from many different tools and set your tool's presets.



Concepts Manual Your Workspace

85

Brush Preferences

On the inner ring of the Tool Wheel are three settings you can use to configure your

brush preferences: size, opacity and smoothing.

1. Size. Use the size slider to determine the size of your brush. Choose one

of the four presets at the top, and set those for fast toggling between

favorite brush sizes.

2. Opacity. Use the opacity slider and presets to set the opacity of your brush.

100% is fully opaque, 0% is fully transparent.

3. Smoothing. Use the smoothing slider and presets to set how much

smoothing you'd like your line to have. 0% smoothing gives you the raw

stroke straight from your hand input, 50% smoothing removes many of the
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bumps for a more polished stroke, and 100% smooths the stroke into a

perfectly straight line between start and end points, no matter how wriggly

it started.

Setting the Presets

Tap one of the preferences to bring up a slider and find your tool's presets. Select a

preset by tapping on it, then drag your finger along the slider to set its value, or tap+hold

the preset value to manually enter a new value. Tap again to dismiss the menu.

If you want to adjust any of the values quickly in flow, just tap+hold+slide on any of the

shortcut buttons to adjust immediately. The slider will open as you slide it and close as

soon as you lift your finger from the screen.

Color
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At the center of the tool wheel, you'll see the current color and opacity of your brush.

Tap the circle to bring up the Color Wheel and find the color picker. Tap+hold the circle

to bring up your Colors menu (Color menu, palettes and mixing are currently only on

iOS).

Undo / Redo

At the side of your Tool Wheel, you will find the undo and redo buttons. Tap the arrow

pointing to the left if you want to undo a stroke. Tap the arrow pointing to the right to

redo a stroke. You can also use the two-finger tap gesture to undo and three-finger tap

to redo. Concepts also has keyboard shortcuts: Ctrl+Z to undo, Ctrl+Shift+Z to redo.

Because Concepts is vector-based, you can always edit your lines instead of undoing

them. You can Select and adjust any line, Nudge it, Slice (erase) it, or delete it entirely

whenever you want.
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The Color Palette (Only on iOS)

Below the tool wheel is the Color Palette. You can customize and add palettes in the

Colors menu. Any palette you activate in the Colors menu will appear on screen. You can

swipe between the different color palettes.
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1. Tap a color to set it for your tool.



Concepts Manual Your Workspace

90

2. Tap+hold+drag to activate the color mixer mode, where the colors in your

palette will blend into a seamless gradient.
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3. Swipe between the different palettes. Access the colors menu, by

tap+holding the color dot in the middle of your tool wheel.

Switching to A Tool Bar

By default, your tools are arranged in the Tool Wheel. Concepts also offers a Tool Bar

option, providing the same tools and options as the Tool Wheel.

You can switch to the Tool Bar in a few ways:
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1. Start moving the Tool Wheel with tap+hold+drag.

2. On iOS, drag the Tool Wheel on either edge of the screen. The canvas

layout manager will highlight, and the Tool Wheel will change into the Tool

Bar.
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3. On Windows and Android, drag the Tool Wheel onto the canvas layout

manager in the middle of the screen and it will turn into the Tool Bar. You

can then drag the Tool Bar to your preferred location.

4. You can also change between the Tool Wheel and Tool Bar in the Settings.

Navigate to Settings → Workspace → Tool Setup.

If you do not see the size, opacity, and smoothness or the color options in your Tool Bar,

you are likely in compact mode. Swipe the Precision or Layers labels towards the center

of the screen to return to normal mode.
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Customizable UI

Everyone works differently, which is why we have made the workspace in Concepts fully

customizable. Every menu on the screen can be moved to maximize your Canvas space

and tool usability.
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Scaling the Tool Wheel and Moving the UI Elements

You can scale the Tool Wheel by pinching or expanding your fingers on it. Find the size

that is most comfortable for you. If you are using Concepts on a desktop device, hover

your mouse over the Tool Wheel and scroll up or down.
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The Tool Wheel, Precision menu, Layers menu, and Object Library are movable canvas

elements. You can customize the Canvas to make it more suitable for your workflow.

Relocate the canvas elements by tap+hold+drag them, then dropping them on the

Canvas.

Minimizing the UI

You can set your workspace into three different modes: normal, compact and hidden

modes.
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1. In normal mode, all menus are visible and the Tool Wheel is completely on

canvas.

2. Swipe outwards on the Layers or Precision menus, or corner the Tool

Wheel to enter compact mode.
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3. In compact mode, the labels are minimized into simple icons, and the Tool

Wheel is docked. The size, opacity and smoothing sliders are hidden from

the Tool Bar. To return to normal mode, drag the Tool Wheel from the

corner, or swipe inwards on the Layers or Precision menus.

4. Once in the compact mode, swipe outward again on the Layers or Precision

menu buttons to enter hidden mode. Hidden mode hides all of your menus

to maximize your workspace.

5. When in hidden mode, tap the Concepts icon on the canvas to bring the

menus back. You can also configure one of your gesture shortcuts to

toggle hidden mode; see Interactions to learn more.

Hiding Canvas Elements

You can hide the Precision, Layers and Objects menus from your Canvas if you don't

need them.
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Tap on the Canvas menu toggles in the Status Bar to choose whether to show or hide

them. Items currently on Canvas show a line under their icon.

Left-Handed Support

Concepts works great for both left-handed and right-handed people. While the app

provides some default options when you first launch it, these are just suggestions. Try

moving the Tool Wheel to the opposite side of the screen and watch the menus switch

orientation. Move your menus so they will not be in the way.

For a step-by-step walkthrough on setting up your workspace comfortably for you, read

Setting Up Your Menus, Brushes and Presets.

https://concepts.app/en/tutorials/setting-your-menus-brushes-and-presets/
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The Infinite Canvas

The Infinite Canvas

Concepts is equipped with an infinite canvas, providing endless room for your ideas as

you sketch and iterate. You will never run out of space to explore your creativity.

Navigating the Canvas

Work on the bigger picture or zoom in to focus on the details without boundaries.
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Pan

Pan around using two fingers and drag, or use the Pan tool. (You can also enable one-

finger pan, which is a great option to get around quickly.) If you are using a stylus, you

can set your Finger Action to pan, which makes navigating while drawing more

convenient. For keyboard users, press the Space key to enter pan mode, and press it

again to exit. You can also hold down Space to temporarily pan and release it to return to

drawing mode.
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Zoom

To zoom in and out, use a two-finger pinch or spread gesture. You can also use the

Zoom tool. You'll notice the zoom snaps at common increments, which help you find

commonly used zoom levels easily. You can also turn the zoom snapping off in the

Settings (not available on iOS).

For precise zoom levels, tap the zoom value in the Status Bar to open an editor, or

tap+hold to edit it inline.

For keyboard users, you can use the keyboard shortcut S to access zoom mode. Drag

with stylus or with mouse to the right to zoom in, and to the left to zoom out. Press S to

access zoom mode, press S again to exit zoom mode. You can also keep S held down

and return to drawing mode when you release the button.
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Rotate

Rotate your canvas using a two-finger twist gesture. You can also use the Rotate tool.

You'll notice there are rotation snaps at common increments, which help you find

standard angles by feel. You can also turn snapping off in the Settings (not available on

iOS).

For precise rotation, tap the angle value in the Status Bar to open an editor, or tap+hold

to edit it inline.

For keyboard users, you can use the keyboard shortcut R to access rotation mode. Drag

with stylus or with mouse to rotate around the axis. Press R to access rotation mode,

press R again to exit rotation mode. You can also keep R held down and return to

drawing mode when you release the button.
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Getting Lost on the Infinite Canvas

If you get lost on your infinite canvas, you can double-tap the zoom value field in Status

Bar to return to the center of your canvas.

On iOS you will see some pointers appear on the outside edges of the screen; tap one to

navigate to the closest off-screen stroke.
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Setting an Artboard

You can set a specific size Artboard to help with composition and framing. Go to

Settings → Workspace → Artboard. You can use one of the presets or create a custom-

sized Artboard. If you have set up an Artboard, you can use it when exporting your

drawing.
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1. Tap on the size to enter values for a custom-sized Artboard.

2. Tap one of the presets under the Artboard size.

3. Tap the three dots to see more presets.

Moving the artboard

Tap+hold a corner of the artboard to move it. This is helpful for framing parts of your

drawings and getting a reference of what size your drawing is based on real-world scale.

When you Export, you can choose to capture the image according to the Artboard's

sizing.

If you don't want your Artboard to be movable, go to Interactions → Stylus → Enable

artboard drag and toggle the option off (Windows & Android only).

To learn helpful techniques on applying Artboards, importing and exporting work and

getting the most out of your Infinite Canvas, enjoy our tutorial Working with Your Infinite

Canvas.

https://concepts.app/en/tutorials/working-with-your-infinite-canvas/
https://concepts.app/en/tutorials/working-with-your-infinite-canvas/


Concepts Manual The Infinite Canvas

107

Using a Stylus

Concepts is at its best with a stylus and optimized for working with pressure and tilt-

sensitive styli such as the Apple Pencil, Microsoft Surface Pen, Samsung S Pen, and many

others. Concepts supports Palm Rejection, writing angle adjustments, and pressure curve

trimming.

If you're using Concepts on Windows, please make sure you have Windows Ink

activated.

If you are using a supported stylus, you can adjust and enable the pressure response

and enable the tilt. The settings might differ depending on your platform.

Pressure Response. Use the Pressure Response sliders to restrict the

pressure response, tailoring it to your drawing style.

Pressure. Enable or disable pressure sensitivity when using a stylus.
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Tilt. Enable or disable tilt recognition for brushes that support it.

Tap & Hold. Enable or disable the tap+hold feature when using a stylus.

Enable Artboard Drag. Enable or disable the ability to drag the Artboard with

a stylus (Windows and Android only).

Barrel Roll (Apple Pencil Pro). Enable or disable stamp rotation (iOS only).

Hover Brush Previews (M2+). Enable or disable showing brush stamp

previews (iOS only).

Shortcut Buttons

The shortcut buttons on some styli can be configured once the pen has been connected.

Buttons can be configured to: No Action, Undo, Redo, Select Last Item, Show Layers,

Show Color Wheel, Tool Setup, and Show Objects.

Eraser

If you use a stylus with a dedicated eraser, you can set the eraser action. The chosen

settings will also be applied for the keyboard shortcut E.

Palm Rejection on iOS

Make sure you turn off Multitouch Gestures in your device's Settings app (under

General). Disabling this prevents conflicts and ensures smooth canvas navigation.
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Brushes and Tools

Brushes and Tools

QUICK SUMMARY

1. Enter the brush menu by tapping an active tool.

2. From the brush menu, you will find Basic Brushes, Tools, and Brush Market.

3. Add different brushes to your Tool Wheel and try them out. We suggest

Nudge for adjusting lines and Slice as a vector eraser.

To use a tool, tap it and start sketching. Tilt and Pressure are supported with several

brushes. Experiment with the different brushes to discover which you like best.

Brush Properties

As mentioned in the Tool Wheel section, the middle ring allows you to adjust the active

brush's preferences: size, opacity and smoothing.
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1. Size. Use the size slider to set your brush's size. Choose one of the four

presets at the top to quickly toggle between your favorite brush sizes.

2. Opacity. Use the opacity slider and presets to set the opacity for your

brush. 100% is fully opaque; 0% is fully transparent.

3. Smoothing. Use the smoothing slider and presets to set the amount of

smoothing you want your line to have. 0% smoothing provides the stroke

directly from your hand input, 50% smoothing removes many bumps for a

more polished stroke, and 100% smoothing refines the stroke into a

perfectly straight line between start and end points, regardless of how it

began.
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Brushes Menu

1. To access the Brushes menu, tap an active tool in the Tool Wheel.
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2. At the top of the menu is your brush preview, which changes to reflect the

brush you choose. On iOS, you can test the different brushes directly in the

preview.

3. In My Brushes, you can select a tool from the Basics Brushes and Tools.

4. Below My Brushes, you will find the Brush Market, which offers different

types of brush libraries. You can buy them individually or unlock them all

with a subscription.
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5. You can edit existing brushes. This includes the basic preferences: size,

opacity and smoothing, as well as some additional options for self-created

brushes (iOS only).

6. You can also create your own brushes. Any brush or brush pack you create

will appear in My Brushes. Read more about brush creation here (iOS only).

Basic Brushes

Pen

The Pen tool reacts to velocity to vary the line width. Draw quickly for thinner strokes or

slowly for thicker ones.

Fountain Pen

The Fountain Pen reacts to velocity to vary the line width. Draw slowly for thinner

strokes or fast to get thicker ones.
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Dynamic Pen

The Dynamic Pen reacts to pressure to vary the line width. Draw lightly for thinner lines;

add pressure to get continuously thicker strokes. Note that the dynamic pen renders a

raster on top of the vector line. This can result in larger file sizes and may make

pixelation on edges more noticeable at higher zoom levels.

Fixed Width Pen

The Fixed Width Pen preserves a constant width while drawing. This is useful for

situations where you need uniform stroke thickness.

Wire Tool

The Wire tool's line width is maintained at any zoom level, making it suitable for

wireframes, light CAD drawings, perspective layouts, and more. Export an SVG file using

Wire to use in another vector program.
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Soft Pencil

The Soft Pencil is modeled after a real pencil. The Soft Pencil reacts to tilt, pressure and

velocity with a supported active stylus. For shading, tilt your stylus like you would a real

pencil.

Hard Pencil

The Hard Pencil is modeled after a real pencil. The Hard Pencil reacts to tilt, pressure

and velocity with a supported active stylus. For shading, tilt your stylus like you would a

real pencil.

Marker Brush
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The Marker Brush has the same texture, transparency and edge as physical markers,

making it great for highlighting, texturing, and illustration work. The Marker’s chisel

follows the rotation of your supported stylus. On iOS, you can see this in action with the

Apple Pencil Pro barrel roll and stamp preview features.

Airbrush

Use the Airbrush to achieve a subtle texture and soft edges, similar to a real airbrush.

Watercolor Brush

The Watercolor Brush blends with consecutive Watercolor strokes on the same layer.

You can interrupt the blending by using other types of strokes in between (like Pen) on

the same layer. You can also use different layers for your Watercolor Brush strokes that

you do not want to blend together. You can use the Hard Mask or Soft Mask tool to mask

different pieces without affecting the blending.
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Fill

The Fill tool allows you to draw any type of shape—simple, complex or organic—with a

stylus or finger, and it fills the positive space inside. Your resulting fill is customizable

with opacity and smoothing. Try the Fill tool for shadows, light and complex figures.

Troubleshooting. Since Fill takes into account the start and end points of your line,

ensure line smoothing is set below 100%. Otherwise, your shape will disappear into a

line or a point.

For a tutorial on the Fill tool, check out Drawing Shapes Instead of Lines: 8 Exercises for

Filled Stroke.

Dotted

The Dotted line is great for annotations and boundaries. The dotted line is a single vector

stroke with raster dots rendered on top.

https://concepts.app/en/tutorials/drawing-shapes-instead-lines-8-exercises-filled-stroke/
https://concepts.app/en/tutorials/drawing-shapes-instead-lines-8-exercises-filled-stroke/
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Tools

Selection

The Selection tool has two modes: Lasso and Item Picker. Toggle between these two

options using the popup at the bottom of your canvas, or use a second finger anywhere

to temporarily toggle the mode.

You can also activate the Selection tool via Tap+Hold anywhere on the Canvas. This is

helpful when you do not want to change tools. You can also assign it as your finger

gesture or stylus button gesture in Interaction settings.

Nudge

The Nudge tool is an intuitive way to edit strokes in Concepts. Nudge allows you to push

your lines like a piece of string or touch your stroke directly to pull it. Use a smaller size

and zoom in to nudge tight corners, or use a larger size and zoom out to nudge gentler

curves. 

Similar to other editing tools, you also get some filters you can use to control whether to

include locked items, masks or focus on a single layer.
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It is worth noting that some items, such as a stroke drawn with 100% smoothing or a

square object with only four points, will act differently when nudged. This is due to the

lack of points in the item's vector path.

Slice Eraser

As opposed to masks, the Slice Eraser tool is a destructive tool that permanently deletes

the part of the stroke it touches. It acts as a more traditional eraser tool. You can filter

out locked items, layers or masks. 

As with other tools, you can adjust the size from the tool wheel or by zooming in and out,

which will affect the relative size of the tool. If you set the width all the way to zero, the

Slice tool will split your strokes into smaller pieces without affecting their size or shape. 

Slicing a stroke will not result in a sharp edge like a hard mask does. That is because the

slice cuts the vector path. 

Please note that imported images cannot be erased with the Slice tool, and you’ll need to

use the Hard or Soft Mask instead.

For a full tutorial on how to use Slice (and when to use it versus the Hard and Soft

Masks), check out The Slice Tool: Divide and Conquer Your Ideas.

Hard Mask & Soft Mask

https://concepts.app/en/tutorials/slice-tool-divide-conquer-your-ideas/
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Mask tools allow you to hide sections of your drawings and imported images, while

retaining their editing capabilities. The Hard Mask gives you a crisp, clean edge, while

the Soft Mask gives the area a soft edge. As with other tools, you can adjust the mask

size from the Tool Wheel or by zooming in and out, which will affect the relative size of

the tool.

Mask tools function a lot like erasers, but are non-destructive, meaning underlying

strokes as well as the strokes drawn with a mask tool, remain editable. You can select

your mask strokes and edit the size, opacity and smoothing as well as apply other

changes.

If your mask strokes interfere with your selection, you can exclude them from the

selection with the selection filters.



Concepts Manual Brushes and Tools

121

To remove strokes completely, try selecting them and using Delete, or use the Slice tool.

Quick Clear Menu

If you want to delete everything from a certain layer, or all strokes, text, images or

measurements all at once, Double-tap the mask tool in the wheel to open a Quick Clear

menu.
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Text

The Text tool is an easy way to add annotations to your drawing. Set the active tool to

Text and Tap anywhere on the screen to add a text label. After you're finished typing, tap

on the canvas to set the label.

Edit Text

To edit a text label, Select it, then tap the text edit icon in the selection popup. This will

take you back to editing mode.

You can select and modify the appearance of your text label just like any other stroke.

Select the text, then change its color or opacity via the tool wheel, use the Selection

popups to rotate, flip, scale, group, lock, delete the text, or use the control points to

transform your text into perspectives and align it with your drawing.

Concepts has full support for any language your device can input, including emojis.

Pan

The Pan tool allows you to pan your Canvas without accidentally selecting or changing

anything in your drawing.

You can also use the keyboard shortcut Space key to access Panning mode:

Tap the Space key to activate canvas pan mode. Drag with the mouse or

finger to pan around. Tap Space again to return to the previous tool.

Keep the Space key held down to quickly access pan mode. Release the

key to return to the previous tool.

Rotate

The Rotate tool allows you to rotate your canvas. Set Rotate in one of the tool slots and

when activated, you'll get a visual handle on the canvas to adjust your canvas rotation.
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You can also use keyboard shortcut R key to access rotation mode:

Tap the R key to activate canvas rotation mode. Click the left mouse button

and rotate in either direction, or use your stylus or finger. Tap the R key

again to return to the previous tool.

Keep the R key held down to quickly access rotation mode. Release the key

to return to the previous tool.

If a selection or a shape guide is active, press shortcut R to rotate the

selection or shape guide.

Zoom

The Zoom tool allows you to Zoom on your canvas. Add the Zoom tool to one of the tool

slots. When activated, drawing right or up will zoom in, and drawing left or down will

zoom out.

You can also use the keyboard shortcut S key to access Zoom mode:

Tap the S key to activate canvas zoom mode. To zoom in, click the left

mouse button, or use your stylus or finger and drag right or up. To zoom

out, drag left or down. Tap the S key again to return to the previous tool.

Keep the S key held down to quickly access zoom mode. Release the key to

return to the previous tool.

If a selection or a shape guide is active, press shortcut S to scale the

selection or shape guide.
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Brush Market

The Brush Market offers a variety of purchasable brushes to add extra flair to your

drawings. You can buy them individually or get them all with a subscription.

Strokes made with these brushes are movable and adjustable like all of our other vector-

based tools, but their size may be limited.
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Many of these brushes have textures made from raster images, meaning they may

pixelate if you zoom in too far, depending on the brush. We encourage you to try them

out and discover which ones you like best. You can also change the look of existing

drawings by selecting your strokes and switching to a new tool. Please note that using

many pixel-based brushes can increase file size and require more performance from your

device.

Creating a Custom Brush (iOS only)

You can create your own brushes and edit brushes from the Brush Market in the Brush

Editor (with Subscription or Essentials). These brushes are image or stamp-based

brushes that you can apply pressure, tilt or velocity settings to, as well as spacing, scatter

and rotation settings.

1. Go to the My Brushes section in the Brushes menu.

2. Tap + New Pack to create a new brush set.
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3. Tap the Untitled brush that appears in the set, or tap Edit Untitled, located

at the top of the viewer. You'll be brought to the Brush editor.
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In the brush editing menu, you'll see the:

4. Live Preview of the brush.

5. The name of your brush (tap to rename).

6. Brush reset (to reset all settings).

7. Duplicate (to duplicate the brush).

8. Delete brush.

Core Setup

Next, you will find the Core Setup for your brush. You have two types of brushes to

choose from: a Stamp brush and a Reveal brush.
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A Stamp brush uses one or several images and draws them on Canvas at

certain intervals to create your brush texture. Similar to ink stamps, they

repeat as they create a stroke.

A Reveal brush uses its stroke to unmask a grain underneath, similar to

how the watercolor brush reveals the texture of the underlying paper. The

resulting stroke of this brush type is even and consistent; there is no

overlap when a stroke doubles back on itself.

Stamp & Grain

We’ve created a complete tutorial on creating stamps and grains for your brushes.

https://concepts.app/en/tutorials/how-make-custom-brush-stamp-and-grain/
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1. Choose a brush type and then move down to Stamp & Grain.

2. Upload a stamp source (JPG or PNG) to use as an image base for your

brush. Stamp here refers to the image, not the brush type above. You can

add up to nine images to use as stamps to add variation. Using several

stamps to create a stroke will give you more randomness to your stroke.
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3. After importing your stamps, import your grain. The grain is a background

image that adds additional texture to your brush. Grains work best when

they are seamless; otherwise, you will see the edges where the image

repeats. Read more on how to make a seamless grain.

4. If you don't want your grain texture to overlap with itself, check the Line up

the grain position for every stroke box.

5. You can edit the scaling of your grain.

6. You can edit the rotation of your grain.

https://concepts.app/en/tutorials/how-make-custom-brush-stamp-and-grain/
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Presets & Basic Dynamics

In Presets & Basic Dynamics, you will find the Size, Opacity and Smoothing presets, as

well as variance graphs that let you adjust how your brush reacts to your stylus' pressure,

tilt, and velocity inputs.

Adjusting Size / Opacity / Smoothing

1. Use the slider to set your brush's default presets.

2. Tap and adjust each preset. You can also Tap+Hold to inline edit the preset

values.

After setting up the base values and presets for your brush, you can adjust the Variance

curve to affect how Pressure, Tilt and Velocity affect your brush's size or opacity.
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Note that smoothing does not have a variance curve.

Note that there is not a variance graph for opacity when the Reveal brush is

selected.

3. To help you adjust your brush, draw a stroke in the Preview. This stroke will

update live as you adjust your variance curve.

4. Choose which of the three—pressure, tilt, or velocity—you want to affect

your brush's properties. You can choose several to affect the brush.
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5. Draw the Variance Graph for your brush directly in the graph. The left side

of the graph represents the low end of pressure, tilt or velocity, and the

right side represents the high end. A graph for a pressure-sensitive

fountain pen, for example, will start small and gradually increase in size

depending on the pressure.

6. The white range behind the graph, reflects the pressure/tilt/velocity range

of your preview stroke. As you adjust the graph, you can see the stroke

update live. The range for your stylus pressure can be edited in Settings →

Stylus.



Concepts Manual Brushes and Tools

134

7. The vertical value axis represents the percentage change in your brush's

properties. By default, the graph is level in the middle, meaning the brush's

properties are as set in the Tool Wheel. Drawing your graph below the

midpoint will make your brush smaller in size or lighter in opacity. Going

above the midpoint will make your brush bigger or more opaque. To reset

your graph, double-tap the vertical value axis.

Shape Controls

With Shape Controls, you can adjust the spacing, scatter and rotation of your stamps.

Your stroke preview will update live to show your adjustments.

Each control handle is split in the middle. This allows you to create a range of random

jitter for your shapes to appear in. When the handles are together, there is no jitter; they

will appear along the stroke path with even spacing or rotation, etc. If you pull the

handles apart, you create a range of randomness in which the stamps can appear.
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1. Shape Spacing allows you to adjust the distance your stamps appear from

each other. Separate the handles to create a more random spacing.

2. As with Size and Opacity, Shape Spacing also has a variance graph you can

adjust.
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3. Shape Scatter will scatter your stamps vertically in relation to your stroke

path. Separate the handles to create a more random scatter.

4. Shape Rotation affects the rotation of the stamp along the stroke line.

Separate the handles to create a more random rotational effect.

5. Rotate Along Stroke Path. By default, your stroke follows the azimuth of the

stylus. If you want your stamps to rotate along the drawn stroke instead,

check this box.

Advanced Settings

Under Advanced Settings, you have the ability to define the layer your brush will appear

in when using Automatic layering.

1. To change the assigned layer, tap on the layer label. By default, this will be

set to Custom. A keyboard, along with several preset layer labels, will

appear.
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2. Choosing Active Layer will always put strokes drawn with the brush on the

currently active layer.

3. You can choose one of the existing layers to set your brush on: Image,

Pencil, Marker, Airbrush, Pen, Wire, Text, Fill, Watercolor or Custom layer.

4. You can also type a custom name for your layer.

For more practice, try our photo-based brush tutorial and create a brush using your own

photographs. You can also try creating an acrylic-based brush with ready-made stamps

provided in the tutorial.

Brush Sharing (iOS Only)

If you have a Concepts subscription, you can share your custom-made brushes with

anyone who has a free Concepts account, or even sell a link to your brush library in an

online store. Shared brushes are read-only, non-editable by anyone except you. Any

change you make to a brush will update live on the accounts you’ve shared your brushes

with. (Please note that sharing and receiving brush packs is only available on iOS at the

moment.)

https://concepts.app/en/tutorials/create-photo-based-brush/
https://concepts.app/en/brushes/creating-acrylic-based-brush/
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Live Sharing a Brush Pack

1. Tap+Hold the title of the brush pack you wish to share.

2. Tap Share in the popup that appears.
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3. In the Brush Pack Sharing screen, you can tap Share to directly share the

pack from your device.

4. You can also copy the link to your brush pack, and share it via email.

5. If you want to unshare your Brush Pack at any point, tap Unshare.

Exporting a Brush Pack File

In addition to live sharing, you can export your brush pack file to share with your

colleagues and friends. This feature is only available for Essentials and Subscription

customers.
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1. To export a brush pack Tap+Hold+Drag on the pack you want to export.

2. Swipe upwards from the iOS Home Bar.

3. Open Files and find the location you want to save your brush pack into.

4. Drag & Drop the brushpack to the location.

If you want to share your brushes via an online store, you can do that, too. Some of our

customers already sell Concepts brushes on Creative Market and Gumroad. If you want



Concepts Manual Brushes and Tools

141

to learn more about this or have a chance to promote your brushes in the Brush Market

send us a message at support@concepts.app.

Importing Brush Packs

Brush pack import is available for customers who have purchased either Essentials or

Subscription.

Importing a Brush Pack via Link

1. Tap the link you have received for the shared Brush Pack. This will open a

browser window.

2. Tap the "Open in Concepts" button.

mailto:support@concepts.app
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3. Tap Accept, and you're good to go.

Importing a Brush Pack File

If you want to import a Brush Pack file, you can import it straight into your brush library.

1. Tap the Import Icon in the Status Bar.
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2. Choose Files from the Import menu.

3. Locate the Brush Pack you want to import in your Files app and tap it.
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4. Once the Pack has been added, you'll see a notification. Go to your Brush

Menu to try out your new brushes.

5. You can also import a Brush Pack file by tapping it directly in Files.

Note that the Imported brushes and Brush Market brushes behave a bit differently from

the ones you have made yourself. If you have purchased Essentials or a Subscription, you

can duplicate and edit the brushes within the pack. To preserve the rights of the creator,

you can't move them out of that pack. If you accidentally edit the original brush, you can

always reset it in the Brush editor.

Custom brushes and brush sharing is currently only available on iOS.
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Colors

Colors

QUICK SUMMARY

1. Access your color wheels by tapping the colored dot inside your Tool

Wheel.

2. You'll find RGB, HSL and COPIC color wheels to choose from.

3. Activate the Color Picker to choose color directly from your Canvas.

The Color Wheels

At the center of the Tool Wheel is a circle representing the current color and opacity of

your active tool.
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1. Tap the color dot in the center of the Tool Wheel to bring up your current

color wheel.

When you open the Color Wheel, you will see your current color wheel, as well as

additional options in the inner ring.
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2. Your current color wheel.

3. Star button. This will take you to the Colors menu, where you can find and

create color palettes (currently available on iOS only).

4. Copic Color Wheel. Currently active.
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5. HSL Color Wheel. Tap to activate.

6. RGB Color Wheel. Tap to activate.

7. Color Picker. Tap to activate the Color Picker.

The Copic Color Wheel

The Copic color wheel is a set of colors picked by Too Corporation to help artists and

designers add consistency to their work. Copic colors are sorted by pigment and

saturation, and are represented on the wheel by a letter + number code. Visit here to

learn more about Copic colors.

1. On the innermost circle, you will see a tonal value spectrum, true black, and

white.

2. Next is a ring of cool, warm, neutral, and tonal grays.

https://copic.jp/en/about/color-system/
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3. Then, the colors in their blending gradients.

4. Drag your finger up or down to turn the wheel.

5. Tap a color to set it to your active brush.

The HSL Color Wheel

The HSL color wheel consists of three sliders: Hue, Saturation and Lightness.
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1. Tap the HSL button to activate the HSL Color Wheel.

2. The Hue Slider is the inner slider on the wheel, and it allows you to change

the base shade of your color.

3. The Saturation Slider is the slider closest to the top of your screen. It

appears as a slider with grey on one end and the pure hue on the other.

This allows you to adjust the amount of pigment in your color.

4. The Lightness Slider is the third slider, located underneath the Saturation

Slider. This allows you to change how light or dark your color is, with the

lightest being white and the darkest being black.

5. To adjust any of these sliders, drag the little circle handles back and forth.

6. You can also Tap+Hold on a value to inline edit it directly.
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The RGB Color Wheel

The RGB color wheel consists of three sliders: Red, Green and Blue. The RGB color model

is an additive color model in which red, green, and blue are added together.

1. Tap the RGB button to activate the RGB color wheel.

2. The Red Slider is the slider closest to the bottom of your screen. The

higher the number, the more red there is in your color.

3. The Green Slider is the slider in the middle. The higher the number, the

more green there is in your color.

4. The Blue Slider is the slider closest to the top of your screen. The higher

the number, the more blue there is in your color.

5. To adjust any of these sliders, drag the little circle handles back and forth.
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6. You can also Tap+Hold on a value to inline edit it directly.

The Colors Menu and Color Palettes (iOS only)

In the Colors menu, you can find color values, create custom colors, and customize

palettes. You can access the palettes via the Color Palette under the Tool Wheel.

1. To access the Colors Menu, Tap+hold the color at the center of the Tool

Wheel or tap the star button on the innermost color ring.

In the Colors Menu, you will see:
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2. Current Color. This shows your current active color. You can tap the color

to open whichever color wheel you have active. Tap+Hold+Drag the color

dot to add it to any of your color palettes.

3. This shows the color values of your current color. You can manually type

the COPIC, RGB, HEX and HSB, or Tap+Drag along the spectrums beneath,
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to change the color.

4. In My Palettes are your custom palettes. Tap a palette to activate it on the

Canvas. Your selected palettes will appear in the swipeable palette menu

under the tool wheel.

5. Tap the + button to create a new palette. You can have an infinite number

of palettes, and each palette can have up to eight colors.

6. At the bottom are the Dynamic Palettes, helpful for choosing matching

shades based on your existing colors.

Adding Colors to a Palette

1. To add a color to a palette, Tap+Hold+Drag the color. You will see a color

dot pop up from the menu. You can drag colors from:

Current color dot

Copic Color Wheel

Other Palette

2. Drop the color in the palette you want, when you see the + icon.
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3. To rearrange colors in a palette, Tap+Hold+Drag the color, and move it to its

new place.

4. To remove a color from a palette, Tap+Hold+Drag the color away from the

palette and release it.
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Using Color Palettes on Canvas (iOS only)

1. In the Colors Menu, choose which palettes you want to activate by tapping

them.
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2. On your Canvas, your active palettes will appear below the Tool Wheel. Tap

a color to set it as your active tool's color.
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3. You can swipe between your active Color Palettes.
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4. To access the color blending mode, Tap+Hold+Drag on the color palette to

choose a color.

How to Drag & Drop Colors into Concepts (iOS only)

You can drag colors straight into your color palette from apps that support Drag & Drop.

Note that the interactions will differ between apps.
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1. Open Concepts and your other app in split-screen mode.

2. Start dragging the color from the other app with Tap+Hold+Drag.
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3. Drag & Drop the color straight to your Concepts color palette and release

when you see the + icon.

Sharing Color Palettes

Live Sharing a Color Palette (iOS only)

If you have a Concepts subscription, you can share your palettes with anyone who has a

free Concepts account. Shared palettes are read-only and non-editable by anyone except

the owner. Any change you make to a palette will update live on the accounts you have

shared your palette with. We recommend naming your palette before sharing it. (Please

note that sharing and receiving palettes is only available on iOS.)
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1. Tap+Hold the palette you wish to share.

2. Tap Share in the popup that appears.
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3. In the Palette Sharing screen, you can tap Share to directly share the

palette from your device.

4. You can also copy the link to your palette and share it via email.

5. If at any point you want to unshare your Palette, tap Unshare.

Color Picker

Concepts' Color Picker can be used to select a color from the screen and also to set the

properties of a particular stroke.
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1. To start using the Color Picker, tap the Color Picker icon in the inner circle

of the Color Wheel.
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2. You can also Tap+Hold on the canvas to bring up the Selection menu, and

toggle to the Color Picker.
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3. When you drag the Color Picker on canvas, the crosshairs at the center of

the Color Picker show you where the color is picked from.

4. The bottom half of the circle around the Color Picker shows the currently

selected color of your tool.

5. The top half of the circle shows the color your Color Picker is currently

touching.

6. To pick the color the picker is touching, just lift your finger or stylus off the

screen.

There are a few additional options for the Color Picker.

7. Alpha On/Off toggle. When Alpha is on, Color Picker detects color and

opacity, ignoring the background. When Alpha is off, color is picked at 100%

opacity and includes the background.
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8. Brush Type. You can tap the Brush Type icon to pick the properties from

the stroke to your currently active brush slot.
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Selection

Selection

QUICK SUMMARY

1. Tap+Hold on the canvas to activate selection

2. Select strokes you want to edit or delete

3. Use selection filters at the bottom of the screen to limit selection results

Concepts is vector-based, giving you the freedom to pick up and move, tweak, or

change any stroke at any time after it is drawn. This is perfect for design iterations,

reorganizing mind maps or preparing materials for clients after feedback.

Selection Methods

There are four ways to select strokes in your drawings.

The Selection Tool



Concepts Manual Selection

169

In the Brushes menu, you can choose the Selection tool (the arrow) and set it as a

separate tool on your Tool Wheel or Tool Bar. Touch the screen to use it like you use any

tool.

Tap+Hold
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Tap+Hold anywhere on the Canvas to activate Selection. You can change the activation

time and which selection method gets activated in Settings → Interaction → Tap+Hold to

suit your workflow better.

Finger Action
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If you are using a supported stylus, configure your Finger Action to Select (Settings →

Interaction → Touch Input → Finger Action). Your finger will work as the Selection tool

while your stylus uses your selected preset in the Tool Wheel.

Layer Selection Popup

If you want to select all strokes on a single layer, you can tap on the active layer to open

the Layer Selection popup. Tapping the selection arrow icon will select everything on

that layer.
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The Selection Menu

Once you have activated Selection by one of the methods, you will find a menu at the

bottom of the screen. This is the Selection menu. The Selection menu helps you filter the

strokes you would like to select from.

When using the Selection tool from your Tool Wheel, the menu will remain

on screen as long as the tool is active.

When selecting with Tap+Hold, the menu will remain for as long as your

finger rests on the screen. With a second finger, you can toggle the menu

buttons to set your filters (more about those below).
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Item Picker (left) and Lasso (right) with their respective selection menus.

In the Selection menu, depending on which toggle you have active, you'll find from left to

right:

1. Selection Type toggle. Tap it to toggle between Item Picker (single item

selection, with the ability to add or subtract strokes individually), Lasso

(multi-select using drag to lasso your strokes), and Color Picker (select

color and vector properties from strokes).

2. Partial On/Off toggle. Allows you to choose whether you would like to

select partial or complete strokes inside your selection. (Only applicable to

Lasso)
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3. Lock toggle. Includes or ignores any strokes you may have locked while

drawing.

4. Layers toggle. You can choose whether to select inside your active layer

only, or inside all layers at once

Selecting with Lasso

1. Activate the Selection tool with Tap+Hold, Selection tool, or by Finger

Action. By default, the first selection option is Lasso.
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2. Drag your finger across or around the strokes you want to select. Lasso

again to subtract from the selection.
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3. If you lasso a selection and decide you want to add further individual

strokes, you can lasso more items or toggle the button to Item Picker via

the Selection Type toggle, and continue adding to your selections.

Selecting with Item Picker
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1. Activate the Selection tool with Tap+Hold, Selection tool, or by Finger

Action. By default, the first selection option is Lasso. Tap the Selection Type

toggle and you will find the Item Picker. This is a single-item selection,

which allows you to add and subtract individual strokes to your selection.

2. Drag the crosshairs over a stroke. Once a stroke can be selected, a circle

appears around the crosshairs.

3. To select a single stroke, let go, and the stroke gets selected. To select

multiple strokes, tap the screen with another finger to select the stroke you

are hovering over.
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4. If you want to add strokes to your selection, access the picker again and

drag the crosshair to your next stroke and tap the screen to add it to your

selected strokes.
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5. To subtract a stroke from your selection, drag the crosshairs to an already

selected stroke. You will see the plus sign turn to a minus sign. Tap the

screen to remove the stroke from the selection.

Color Picker

If you tap through the Selection toggles from Lasso to Item Picker, the third toggle is the

Color Picker. This vector color picker offers a few more capabilities than standard color

pickers in other apps. It allows you to select and remember color, brush, and stroke

properties, and set them to your tools. Read more about the Color Picker in the Color

section.
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The Selection Popup

Above the selection box is a Selection popup. This tool offers many useful features to

help you work with your strokes.

1. Copy to clipboard. Tap the paperclip to copy your selection to your device's

clipboard. Tap Paste in any app supporting the feature to paste in a

transparent background PNG of your selection. Inside Concepts, you can

paste strokes from the clipboard from the Import menu. You can also attach

colors from other apps to your clipboard, and access them on the Color

Wheel (iOS only).
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2. Duplicate selection. You can duplicate anything you have selected. Just

touch Duplicate and it will create a copy for fast iterations. Drag the

duplicate to a new layer to keep your iterations in order.

3. Group selection. This allows you to bundle all strokes inside your selection

into a single group. You can then select the entire object by selecting a

single stroke inside the group, instead of having to re-select multiple

strokes. To ungroup them, just select the object and tap the group button

again.

4. Lock selection. The Lock button locks your selection from subsequent

selections and adjustments you might make. You can access the locked

item again by allowing selection of locked items in the Selection menu

filters.

5. Delete selection. To remove a selection, tap the Delete button.

6. Flip Horizontally. This flips your selection horizontally. Great for creating

reflections and shadows.

Flip Vertically. This flips your selection vertically. Great for creating reflections and

shadows.

Adjusting a Selection

Once you have selected a stroke or group of strokes, you will notice the Selection

toggles at the bottom of the screen have changed to give you a few more helpful

toggles.



Concepts Manual Selection

182

1. Rotate. Allow or disable rotation for your selection. Toggle the rotation

status on/off.

2. Scale / Stretch / Off. Scale scales the whole selection, scaling the stroke

size as well. Stretch stretches strokes but keeps the same tool size. When

scaling/stretching is turned off, your strokes are locked from scaling or

stretching.

3. Filters. Tap this to show the Selection menu items, Item Picker, Lasso,

Color Picker and selection filters.
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4. To Scale your selection, use a two-finger gesture to pinch and spread your

selection. You can also use the Zoom tool or keyboard shortcut.



Concepts Manual Selection

184

5. To rotate the selection, use a two-finger gesture to rotate your selection.

You can also use the Rotation tool or keyboard shortcut.
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6. You can also select an exact angle rotation and scale of your selection

using the angle and size field below the status bar at the top of the Canvas.

Tap+Hold the angle or size field to bring up a keyboard, and type in your

custom value. When rotating, objects will rotate clockwise. To avoid

accidentally turning or scaling your selection when moving the object, first

lock your rotation and scale toggle on the Selection menu.

Transforming a Selection

You can use the four corner handles around a selection to scale or distort the selection.

These handles are your Control Points.
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1. Drag directly from a single point to scale/stretch a selection. Put another

finger on the screen to lock the aspect ratio while resizing.
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2. Tap to activate one corner point and drag to distort your selection.
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3. Tap to activate two corner points and drag with one finger to skew the

selection.

4. Tap to activate two corner points and pinch or spread with two fingers to

warp your selection.

Please note that scale/stretch needs to be active for the control points to show.

Highlight Selection
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1. By default, Concepts highlights your selected strokes, graying the

unselected content. The active selection is also brought to the front,

meaning that if the stroke you selected is behind other strokes, it will be

visually presented on top.

2. In the Settings → Interaction → Tap+Hold menu, you will find an option to

Highlight Selection. Toggle this on or off as you prefer.

3. When Highlight Selection is toggled off, the color of the drawing stays as it

is. The active selection is still brought to the front.
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Highlight Selection and Nudge

You can also use Highlight Selection with the Nudge tool.

1. When Highlight Selection is turned on, you will see both before and after

strokes as you nudge lines on your screen with the original stroke slightly

grayed out.

2. When Highlight Selection is turned off, you only see the adjusted stroke.
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Layers

Layers

QUICK SUMMARY

1. Tap the Layers icon on the status bar to show layers.

2. Use Manual layering, or let Concepts sort your layers automatically based

on the drawing tool.

3. Tap an active layer to open the Layer Options menu where you can delete,

rename or merge your layers.



Concepts Manual Layers

192

Concepts comes with adjustable Layers to help organize your work. You can have up to

five layers if you are using a free plan, or infinite layers as a Pro. By default, Concepts

uses automatic layering, placing strokes on different Layers based on the tool used.

Interface

Layer panel

1. Toggle Layers. Tap the Layers icon in the status bar to toggle the Layer

panel visibility on or off.

2. Layers. Tap the Layers button to minimize the Layers panel.

3. Layer Sorting. Tap the Layer Sorting button to toggle between Automatic

and Manual modes.

4. New Layer. Tap the New Layer button to add a layer. The new layer will be

added above the currently active layer. You can also drag a selection to the

New Layer button to create a new layer for the dragged strokes.

5. Active Layer. To activate a layer, tap it. The thumbnail of your currently

active layer has a stronger thumbnail outline, and the layer name will have a



Concepts Manual Layers

193

gray background.

Tap on the active layer to open the Layer Options menu.

Double-tap to enter Focus Mode.

Drag a selection to a layer to move the strokes to that layer.

6. Non-active Layer.

Tap a non-active layer to activate it.

Double-tap on a non-active layer to activate it and directly enter Focus

Mode.

Drag a Selection to a layer to move the strokes to that layer.

7. Visibility. Toggle the layer visibility by tapping on the eye icon. Scrub on the

eye icons to enter Focus Mode.

Layer options menu

Tapping an active layer opens the Layer options menu.

1. Select All. This selects all the strokes on the layer.

2. Lock Layer. This locks the layer. You cannot draw or edit the layer when it is

locked.

3. Duplicate Layer. This makes a copy of the layer.

4. Delete Layer. This deletes the layer and all the strokes on the layer.
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5. Merge Down. This merges the layer with the layer below it.

6. Rename Layer. You can rename your layer.

7. Opacity. You can adjust the opacity of the layer.

Rearranging Layers

You can rearrange the Layers in any way you want. Rearranging the Layers will set your

Layer Sorting to Manual.



Concepts Manual Layers

195

1. Tap+Hold on the layer you want to move.

2. Drag it up or down on the layer list to the desired position.

Using Layers

Layer Sorting and adding layers

Layers come in two modes in Concepts: Automatic and Manual. You can switch between

them by tapping the Automatic or Manual button at the top of the Layers menu.

Whenever you manually change the layer order or switch the active layer, Concepts will

automatically change the layer mode to Manual.

You can create Layers manually or let Concepts handle it. By default, layering is set to

Automatic. A new layer is created when you change your drawing tool.

1. Automatic layering
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Automatic layering is the default sorting mode in Concepts. Concepts will add a new

layer when it recognizes a new tool being used. When you switch to a different tool, it

will draw on that tool's designated layer. (Note that the Pen, Fountain Pen, Dynamic Pen,

Fixed Width, and Dotted Line tools all share a layer, as do the Soft and Hard Pencils.) If

you are in Manual sorting mode, you can return to Automatic sorting by tapping the

Sorting button.

2. Manual layering

Manual layering allows you to draw with any tool on any layer. In Manual mode,

everything you draw ends up in the active layer, no matter the brush. You can switch

between the different modes with a tap on the Sorting button.

3. Adding Layers

Tap the New Layer button to add a layer. The new layer will be added above the

currently active layer. You can also drag a selection on the New Layer button, to create a

new layer with the selected strokes.

You can use five layers for free and unlock unlimited layers with Concepts Pro (Essentials

or Everything Subscription).
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Focus Mode

Concepts has a feature called Focus Mode. This mode focuses on a layer and allows you

to work on only that layer that is in focus.

1. Double-tap on a layer to activate Focus Mode.

2. You can also activate Focus Mode by scrubbing on the eye icons.

Once in Focus Mode, the content of the focused layer will be fully visible but the other

layers will be subdued.
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3. Double-tap on the focused layer to exit Focus Mode.

4. Tap on another layer to move the focus to that layer.

5. You can also focus on another layer by scrubbing on the eye icons.
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Precision Tools

Precision Tools
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QUICK SUMMARY

1. Use Grids to create consistent layouts and perspectives.

2. Use Snap to make your strokes follow grid lines or snap to other key points.

3. Set scale for your drawing to work with real-world measurements.

4. Activate a Shape Guide or use the Shape Recognition to draw perfect

squares, circles, and more.

Concepts has several Precision Tools to help you achieve accurate lines, perfect shapes,

and precise measurements in your drawings. You can also set a scale for your designs.

Interface

1. Toggle Precision. Tap the Precision icon in the status bar to show or hide

the Precision panel.
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2. Precision. Tap the Precision button to minimize the Precision panel.

3. Grid. Toggle Grid by tapping the checkbox. Tap the other side to access

your Grid options.

4. Snap. Toggle Snap by tapping the checkbox. Tap the other side to open the

Snap menu.

5. Measure. Toggle Measure by tapping the checkbox. Tap the other side to

open your Measurement settings.

6. Guide. Toggle the Shape Guide by tapping the checkbox. Tap the other side

to open your Shape Guide menu.

7. Recognition. Toggle the Shape Recognition by tapping the checkbox. Tap

the other side to open your Shape Recognition settings.

Grids

Grid is a framework that helps you structure your content. You can use the grid as a

visual reference, or you can have your strokes either Snap to or Align with the grid.

1. Tap Grid under Precision to toggle the grid on or off.

2. Tap the label with the grid name to bring up the Workspace to choose the

grid type.
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3. Once you have enabled the grid, a Grid layer will be added to your Layers.

You can drag the Grid layer anywhere in your Layers list. Note that you

cannot draw or drag any selections to the grid layer.

Grid Layer

Once you have activated the grid in the Precision menu, the Grid Layer is added to the

bottom of your layer list.
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1. You can Tap+Hold+Drag the Grid Layer to move it anywhere on the layer

list.

2. Double-tap the Grid Layer to enter Focus Mode.

In the Grid Layer menu, you will find:

3. Delete layer button. This will delete your grid and toggle the Grid off.

4. Tap the Settings button to get to the Grid Settings.

5. Drag the slider to adjust the opacity of the Grid Layer.

Grid Types

Concepts has five basic grids and three perspective grids: Dot Grid, Graph Paper, Lined

Paper, Isometric Grid, Triangle Grid, and 1, 2 and 3 Point Perspectives. Select the grid

from the list in the Workspace menu.
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1. Scroll the list of grids in Settings -> Workspace.

2. Tap to choose a grid type.

3. To edit the grid or choose from the grid presets, tap the active grid or tap

the Edit Grid button.

Basic Grids

With the basic grids, you can edit several settings. Note that the grid units are

determined by the drawing units you've selected in the Workspace menu.
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1. Preset. Choose from several grid presets.

2. Spacing. Spacing defines the distance between the main lines or dots.

3. Divisions. Divisions determine how many subdivisions there are between

the major lines. Set value to 1 to only show the main lines. Available for
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Graph Paper and Lined Paper grids.

4. Line Weight. Set the thickness of the grid lines.

5. Color. Use the automatic color that adapts to your canvas or choose a

custom color.

6. Opacity. Set the opacity of the grid. This option is available when using a

custom color.

7. Orientation. Set the orientation of the grid to landscape or portrait. Available

for Lined Paper, Isometric Grid, and Triangle Grid.

8. Confine to Artboard. This confines the grid lines to only show within the

artboard. This option only has an effect if there is an artboard on canvas.

Perspective Grids

With the perspective grids, you can edit several settings. Editing the vanishing points

happens directly on the Canvas. Note that the grid units are determined by the drawing

units you've selected in the Workspace menu.
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1. Preset. Choose from several grid presets.

2. Vanishing Points. Tapping this button takes you to the canvas, where you

can move the vanishing points and adjust the grid to your liking. You can

also edit the grid on canvas at any time by Tap+Holding on the vanishing

points or by activating the Grid layer.
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3. Density. Choose the number of vanishing lines that appear in the grid.

4. Line Weight. Set the thickness of the grid lines.

5. Color. Use the automatic color that adapts to your canvas or choose a

custom color.

6. Opacity. Set the opacity of the grid. This option is available when using a

custom color.

7. Orientation. Set the grid orientation of the grid to landscape or portrait. By

default, the grid is created in the same orientation the device was in when

the drawing was created.

8. Confine to Artboard. This confines the grid lines to only show within the

artboard. This option only has an effect if there is an artboard on canvas.

Editing Grids on Canvas

You can also edit the grids directly on the canvas.
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1. To enter the grid edit mode, activate the Grid layer in the Layers menu.

2. With perspective grids, you can access the grid editing mode also by

Tap+Holding on a vanishing point.

While the Grid layer is active, zooming and panning the canvas work normally, but it is

also possible to edit the grid. All grids have a rotation handle that you can use to set the

grid to a specific angle.
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3. Drag the handle to rotate the grid.

4. A snap target line is shown every 45 degrees. Release the handle while the

snap target line is showing to snap to that angle, or keep the handle still and

wait for the snap target line to disappear to set a specific angle close to the

snap.

5. When rotating the grid, the angle is shown in the status bar. Tap+Hold the

value to edit it directly.
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6. To move the grid, drag the grid from the crosshairs at the center of the

horizon line, or drag the line itself.

7. With the perspective grids, you can move all of the vanishing points by

dragging them.
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8. Tap the vanishing points to activate them. When the points are active, you

can pan them with one finger or move them around with two fingers just

like when adjusting a Selection. To scale the grid, select all vanishing points

and use two fingers to scale.

9. Tap Done in the Editing Grid toast notification to exit the grid editing mode.

You can also tap away from the editing controls on canvas or activate

another layer.

Snap

You can use Snap in two ways in Concepts: snapping while drawing, and snapping

while editing.
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1. Tap Snap under Precision to toggle the snapping on or off.

2. Tap the Options to bring up the Snapping Options.

Snap Options

When you open the menu for Snap Options, you will see a variety of options for snapping

while drawing and editing.

Snap While Drawing
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1. Snap to Grid. With this option enabled, all strokes are drawn to follow the

closest grid line available. The Wire and Fixed Width brushes can be used

to draw strokes with fewer points. Try these tools if you want to export SVG

or DXF.
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2. Align to Grid. This option aligns strokes directionally with the grid lines but

does not limit them to the grid lines.

3. Allow Traceback. With the Allow Traceback option toggled, you can retrace

your strokes and redo your lines.

4. Allow Turns. Enable this option to allow making turns when drawing while

drawing with Snap and Align to Grid.

5. Auto-complete. Connects the start and end points of your strokes. You will

see small circles appear showing you possible points to connect to. Tap the

one you want to connect to. Autocomplete can be used together with Snap

to Grid and Align to Grid. With Align to Grid, the strokes can snap to any

strokes intersecting with the trajectory of the stroke.

6. Active Layer Only. This option only applies to the auto-complete. Activate

this option to only auto-complete to lines on the currently active layer.

Drawing with Snap + Grids

When drawing with Snap, each grid has its own guide settings that correspond with the

grid's directional constraints.

Dot Grid

Snap: Draw horizontal and vertical lines only.

Align: Draw horizontal, vertical, and 45-degree diagonal lines.

Graph Paper

Snap: Draw horizontal and vertical lines only.

Align: Draw horizontal, vertical, and 45-degree diagonal lines.

Lined Paper

Snap: Draw horizontal and vertical lines only.

Align: Draw horizontal, vertical, and 45-degree diagonal lines.
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Isometric Grid

Snap + Align: Draw 60-degree diagonal lines only.

Triangle Grid

Snap + Align: Draw 60-degree diagonal lines only.

1 Point Perspective

Align: Draw horizontal and vertical lines, and perspective lines directing

toward the single vanishing point on the horizon line.

2 Point Perspective

Align: Draw vertical lines, and perspective lines directing to each of the

two vanishing points on the horizon line.

3 Point Perspective

Align: Draw perspective lines only that direct toward any of the three

vanishing points on the canvas.

Snap While Editing

When you Select a previously drawn stroke, you can adjust and move it with the help of

Snap. You can snap the stroke to other key points or to the grid.
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1. Snap to Grid. Snap to Grid snaps the key points of your selection to the

grid.

2. Snap to Key Points. Snap to Key Points snaps the key points of your

selection to the key points of other strokes.
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3. Active Layer Only. Active Layer Only allows you to snap to strokes on the

current layer only.

Snap Points

Depending on how the stroke was created, it has different snap points it will use to snap

with.

With single-stroke selections, Snap points are the beginning and end points

of any given line, and the four corners and the center point.

If the stroke is drawn with Snap to Grid, the apexes work as Snap targets as

well.

With multi-stroke selections, Snap applies to the four corners and the

center point of the selection.

When used with Shape Guides, Snap applies to the handles and the center

point.

Grid Drawing Tutorials

We have several illustrated tutorials available for learning to set up and draw with the

grids, and improve your perspective drawing skills.

How to Set Up a Perspective Grid in Concepts - Learn how to set up and

customize your perspective grids in Concepts.

How to Sketch with a Perspective Grid - These drawing exercises will help

you learn how to use 1 point, 2 point and 3 point perspective grids to sketch

designs and illustrations.

Learn to Draw: Basics of Perspective - Part of our Learn to Draw Series, this

video tutorial will help you to understand the fundamentals of perspective

drawing.

How to Create Lined Paper - Learn how to set up lined paper for note taking

and handwriting practice on your infinite canvas.

https://concepts.app/en/tutorials/how-set-perspective-grid-concepts/
https://concepts.app/en/tutorials/how-set-perspective-grid-concepts/
https://concepts.app/en/tutorials/how-sketch-perspective-grid/
https://www.youtube.com/watch?v=jCOb5a3Q7Jk
https://concepts.app/en/tutorials/how-create-lined-paper/
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Measure

In Concepts, all the strokes, selections, and imported items have measurement data

attached to them. These measurements are not visible by default, but you can display

them by enabling the Measure option in the Precision menu.

Setting up the measurements
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1. Tap Measure under Precision to toggle the Measurements on or off.

2. Tap the unit and scale on the other side of the toggle to see and edit your

Measurement Options.

Measurement Options
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1. Drawing Scale. Define your Drawing Scale. You can choose from one of the

presets or set a custom scale.

2. Display Units. Concepts offers different unit systems: Digital, Metric, and

Imperial.
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3. Display Format & Precision. Set the display format and fidelity of precision

for your measurements.

4. If you want to change the side where the measurement labels are shown,

toggle the Show stroke on the right side while drawing. This is useful if you

are left-handed.

5. If you want to show the percentage value of your selection's Width and

Height, toggle the Show scale in the status bar for selections option.

Measurement Layer

Once you have activated the Measure in the Precision menu, the Measurement Layer is

added to the top of your layer list. The Measurement Layer also allows adding static

measurements to your drawing that are not associated with any strokes.

1. You can Tap+Hold+Drag the Measurement Layer to move it anywhere on

the layer list.

2. Double-tap the Measurement Layer to enter Focus Mode.

In the Measurement Layer menu, you will find:
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3. Delete layer button. This will delete your Measurement Layer and toggle

Measure off. Please note that this will also delete all the measurements you

might have added to your drawing.

4. Tap the Settings button to access the Measurement Settings.

5. Drag the slider to adjust the opacity of the Measurement Layer.

How to set Drawing Scale and Units

Scale is the ratio between the size of something in drawing and its actual size. For

example in 1:100 scale, a 1 cm line on the screen represents a 100 cm line.
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1. To set your Drawing Scale and Units, go to Settings -> Workspace ->

Measurements -> Drawing Scale. Choose one of the scale presets or set a

custom scale.

2. Set your Units. Select the units you want to use from Digital, Imperial, and

Metric.
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3. Choose the Format and Precision your units are displayed in.

After setting your units and scale, all tool and measurement values will appear according

to the selected scale. For example, when changing from points to inches, a pen set to 2

points would be converted to 0.015 inches. Your tool presets will remain the size you

have set, but the units will be converted.

How to Set Scale with an Imported Plan or Photo

If you want to set scale accurately in a project, you will need to know one accurate

measure for reference.

1. Import a reference image onto your canvas.

2. Turn on Precision, and activate Measure.

3. Activate the Line guide.
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4. Align the handles on your reference image to the segment for which you

know the measure.

5. Double-tap the crosshairs at the center of the Line guide to contain the

boundaries of the line to your measurement when you draw.

6. Tap the 1:1 ratio beside Measure, or the 1:n Set Scale in the bottom menu.
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7. You will notice the values under Drawing Scale have been filled in with the

current length of the Line guide.

8. Enter your measure of reference in the second field, and dismiss the menu.

Your scale is now set to your measure of reference.

For a fully illustrated tutorial on setting scale, check out Scale and Measurement in

Concepts.

Types of Measurement Labels

When Measure is active, a measurement label updates live with your stroke as you draw.

You can also add static measurement labels to your plan for reference using the Shape

Guides and Selections.

https://concepts.app/en/tutorials/scale-and-measurement-concepts/
https://concepts.app/en/tutorials/scale-and-measurement-concepts/
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Dynamic Measurements

Dynamic measurements are live measurements associated with a drawn stroke or a

filled in area. You will see these measurements update as you draw.

1. When you tap a dynamic measurement label, it remains attached to your

stroke and will "stick" on the layer you drew it on.

Selecting a dynamic measurement will also select the stroke it is

attached to. They will be treated as the same object when editing.
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2. Select a line or fill you've previously drawn to show its measurement label.

Tap it to set it on the canvas.

Static Measurements

Static Measurements are measurement labels applied to the canvas when a line or fill is

Selected, or when using a Shape Guide.
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1. A Shape Guide allows you to create a static measurement, or a label

without an associated line. Just tap the shape guide's measurement label

without tracing the corresponding line.
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2. You can also enter a custom value by Tap+Holding on your shape guide's

measurement label, and the entire guide will adjust to your value.

3. Static measurement labels are saved to the Measurement layer. This layer

appears automatically when Measure is activated.

Drawing with measurements

When you start drawing with the Measure enabled, you can see a live measurement

attached to your stroke showing the length or area of the stroke.
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1. When Measure is enabled, you will see the measurement attached to your

stroke. Tap the measurement label to stick it to the canvas.
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2. If you want to resize your stroke to a certain length, select a stroke and

then Tap+Hold its measurement label. You can also edit the stroke length

by Tap+Holding the length indicator up in the status bar, or using the

Measurement Popup.
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3. Note that measurement labels will only appear and export with your

drawing:

While Measure is active.

When your Measurement layer is toggled to visible.
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We have an illustrated tutorial on working with Scale and Measurement here. This tutorial

walks you through how to work with measurement labels and how to set scale to

drawings and imported plans of various types.

Area Measurement

The Fill tool is different from all the other brushes as it also shows the area. You can use

this to estimate material consumption in your renovation plans or quickly check the size

of a certain area in your plan.

1. When drawing, the area measurement appears in the center of the fill.

Once the fill is finished, tap the measurement to save it on canvas.

https://concepts.app/en/tutorials/scale-and-measurement-concepts/
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2. You can resize your area to a certain measure. Select the fill and Tap+Hold

the measurement label. You can also edit the stroke length by Tap+Holding

the length indicator up in the status bar, or using the Measurement Popup.

Editing Measurements

To edit a Static Measurement label, select the label on the Measurement Layer.
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1. Copy to Clipboard. Copy the measurement label to clipboard.

2. Duplicate. Duplicate the measurement label.

3. Delete. Delete the measurement label.

4. Flip Horizontally. Flips the measurement label horizontally. The label text

will not be flipped.

5. Flip Vertically. Flips the measurement label vertically. The label text will not

be flipped.



Concepts Manual Precision Tools

238

6. To reposition a label attached to a stroke, Tap+Hold+Drag the label along

the stroke path.

Measurement Popup

On the Status Bar, you will see a field stating your current relevant zoom, rotation and

selection status. In the Measurement Popup, you can quickly access zoom and rotation

presets for your canvas or selection, lock and unlock canvas zoom and rotations, and

use the fields to control a selection's dimensions.

With a single stroke selected, you will see the length, width, height and

rotation of the stroke.

With multiple strokes or an image selected, you will see the width, height

and rotation of the selection.

With a fill stroke selected, you will see the width, height, length, area and

rotation of the selection.
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1. Tap on the measurement field in the status bar to open the Measurement

Popup.
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2. Tap the values in the popup to inline edit them. You can enter

measurements in any unit, and they will be automatically converted to

match the document units you have selected in the Workspace Settings.

3. You can lock or unlock the relation of width and height when adjusting the

values. Tap the chain to toggle.

4. You can use the presets to rotate and scale the selection.

Shape Guides

The Shape Guides are templates you can use to draw your desired shapes. Depending

on the guide, you can control the width, height, edge, and radius of the guide to trace

along.

1. Tap Shape Guide under Precision to toggle the currently active Shape

Guide on or off.

2. Tap the Shape Guide name on the other side of the toggle to see the

different Shape Guides.

3. Concepts has five Shape Guide options; line, arc, angle, ellipse, and

rectangle.

Using Shape Guides

When you activate a Shape Guide, you will see some additional elements on your

canvas.
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1. The Shape Guide. The gray template shows the path where the stroke will

be drawn. The thickness depends on your tool width. Draw anywhere on

screen to draw the shape.

2. The handles. Tap+Hold+Drag a handle to pull it to change the shape.

3. The crosshairs. Tap+Drag the crosshairs at the center of the Shape Guide

to move the guide. If you double-tap the crosshairs, each guide will

respond with a special function:

The Line guide will limit your drawn stroke to between the handles.

The Arc guide will become a perfect half-circle.

The Angle guide will snap to 90 degrees.

The Ellipse guide will become a perfect circle.

The Rectangle guide will become a perfect square.
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4. To rotate a Shape Guide, use the two-finger gesture. You can also use the

angle field in the status bar at the top of the canvas, the "Rotate" tool, or the

keyboard shortcut "R".

Using Shape Guides with Measurements

When you have both Shape Guide and Measure active, you will see the relevant

measurements of your guide. You can Tap+Hold the measure to edit your guide

accurately.

You can use the Shape Guides to create measurement labels that are not attached to a

stroke. Read more about measurement labels created with Shape Guides in the Static

Measurements section.
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To set scale using the Line Guide, read the How to Set Scale with an Imported Plan or

Photo section.

Shape Recognition

Shape Recognition allows you to quickly turn rough drawings into perfect shapes. Start

drawing a shape and then hold at the end of the final stroke to detect a shape.

1. Tap Recognition under Precision to toggle the Shape Recognition on or off.

2. Tap the options on the other side of the toggle to see the options for the

Shape Recognition.
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3. In Settings -> Interaction -> Draw & Hold menu, you can adjust the Shape

Recognition Settings. You can toggle the "Enable Shape Recognition" to

turn it on or off.

4. You can change the Activation Time by adjusting the slider.

Using Shape Recognition

1. Start by drawing a shape with one to four strokes.

2. Hold at the end of the final stroke to detect a shape.

3. When the shape has been detected, you can scale and rotate it by moving

your stylus without lifting it from the screen.

Supported shapes include straight and curved lines, arrows, triangles, squares,

rectangles, circles and ellipses.

If you're just getting started using the Precision Tools in Concepts and want some

practice using the tools, check out our beginner tutorial How to Design in Concepts.

https://concepts.app/en/tutorials/how-design-concepts/
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Objects

Objects

QUICK SUMMARY

1. Tap the Objects icon to open the Objects menu.

2. Purchase packs individually in the Object Market or subscribe for full access.

3. Tap a Pack to see all the Objects in the pack.

4. Tap or drag & drop objects to add them on the Canvas.

5. Subscribe to access Make Your Own Objects.

Objects are adjustable, royalty-free vector assets. You can purchase Object packs

individually from the Object Market or gain access to all with a subscription.

If you have a subscription, you can Make Your Own Objects as well. On iOS, you can also

share your self-made Objects with colleagues via your Concepts Account.
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Interface

Object Library View

1. Objects icon. Tap the Objects icon in the Status Bar to open the Objects

menu.

2. Close. Close the Objects menu by tapping the "x" button.

3. Filters. Tap a filter to display Objects only in your desired category.

4. Search. Search for a pack or an individual Object.

5. Toggle the arrow to hide or show a section in the Objects menu.
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6. Pack Name. This indicates the name of the Object pack. You can also tap

the pack name to open the pack.

7. Favorite pack. Add an Object pack to your favorites. Favorite packs appear

higher in your Object Library, under the Favorites heading.

8. Purchase status.

9. Pack Description. A short description of the Object pack. You can also tap

the pack description to open the pack.

10. Pack preview. This provides a preview of the Objects in the pack. You can

also tap the pack preview to open the pack.
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Move, Pin and Resize the Object Panel

You can change the position and size of the Objects Library panel at any time.

1. To move and pin the Object panel, drag the handle at the top of the panel

and move it to your desired location on the Canvas.

2. To resize the Objects panel, tap+drag the bottom left or right corner

handles of the panel and adjust the width. You can condense the panel
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down to two columns or expand it to six columns.

To close the Objects panel, tap the X close button or drag it back to the status bar

where you found it.

Object Pack View

1. Back to Packs. This will take you back to the Object Library.

2. Favorite pack. Add an Object pack to your favorites. Favorite packs appear

higher in your Object Library, under the Favorites heading.

3. Purchase status.

4. Search. Search for an individual Object within the current pack.

5. Toggle Object name visibility. Choose to show or hide the Object names.



Concepts Manual Objects

250

6. Favorite Object. Favorite Objects appear higher within the Object Pack.

7. Object list. Tap an Object to add it to your Canvas. The placed Object is in

the selected state, allowing you to move, rotate and resize it.

Using Objects

1. To start using Objects, tap the Object icon in the Status Bar to open the

Objects menu.

2. Scroll through the Object Library to the pack you want to use and tap to

open it.

3. Scroll to the Object you want to use.

4. Tap or drag the Object you want to use to add it to the Canvas.

5. The Object will be selected, allowing you to adjust it (move, resize,

duplicate, mirror, change color or tool etc.). Tap on the Canvas to deselect

the Object.

6. To switch to another Object pack, tap the Back to Packs button, and you will

return to the library view.
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Search for Objects

You can search Objects in either the Library view or the Pack view.

Searching in Library View

1. Searching for Objects in the Library view displays all Objects in every pack

that match your search.

2. You can scroll through the search results as you would with the Object

Library.
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3. Tapping the pack name or description will move you to the pack view.

4. You can add Objects in the search results directly from the library view by

tapping or dragging them to the Canvas.

Searching in Pack View

5. Searching for Objects within the pack only displays relevant results in the

current pack.

6. All relevant results will be shown in the Pack view.

7. You can add Objects as you normally would by tapping or dragging them

onto the Canvas.

Favoriting Objects
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You can mark your favorite packs and Objects by tapping the star icon on the pack.

Favoriting a pack will add it to a favorites section in the Object menu. Favoriting an

individual Object moves it to the top of the pack's list.

Favoriting Packs

1. Tap the star icon in the Library view to mark it as a favourite.

2. Favorited packs will be added to the Favorites section at the top of the

Object Library view. You can remove a pack from the favorites by tapping

the star again.

Favoriting Individual Objects

3. To add an individual Object to your favorites, tap the star icon next to the

Object within the pack view.

4. Individual Objects that have been favorited will show at the top of the pack

view under Favorites.
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Objects Market

From the Objects market, you will find pre-made Objects available for purchase. You can

buy the Object packs individually, or get everything by subscribing in the Pro Store.
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1. With the free plan, you can use five Objects for free per month.

2. You can purchase each Object pack individually or get everything with a

subscription in the Pro Store.

Make Your Own Objects (MYOO)

You can create your own Object packs with anything you draw. Make Your Own Objects

is a paid feature, available as part of the monthly or yearly Everything subscription.

Creating an Object Pack

1. To create a new Object Pack, tap the + button at the My Packs section of

the Object Library.
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2. You will be prompted to Name Your Pack!

3. Once you've chosen a fitting name, tap Set Name.
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4. You will be taken to the Pack view of your newly created Object pack.

5. To create an Object, select the strokes you want, then drag & drop them

anywhere into the Object pack view. Once created, your Object will

automatically group your strokes, so you can move and edit it more easily.

6. You can also tap the + in the Object pack view when you have an active

selection to add strokes as an Object.
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7. Once you have added the items you want to your Object Pack, tap the Back

to Library button.
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8. Your Object pack will appear in the My Packs section of the Object Library.

You can edit and add Objects to your Object pack whenever you want. You

can favorite your self-created Objects just as you would with other packs.

Editing Object Pack Settings

You can edit your Object pack's name, add a description or change the brush property

settings at any time.

1. To start editing your Object pack's settings, tap the ... icon next to your

Object pack in the Object Library.
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2. Tap Edit to access Object pack settings.

3. You can also delete your Object pack. Please note that this cannot be

undone.

4. You can also access the Object pack settings by tapping the settings icon

in your Object pack's pack view.
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5. In the Object pack Settings, you will see all the options you can apply to

your pack. You can get back to the Object Library / Object pack view by

tapping the Back to Library or Back to Pack button.

6. From here you can change the Object pack name you set when creating

the Object pack.
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7. Here you can add a description for your Object pack. When using the

search function in the Object Library, the search will also look for words in

the pack description.

8. In the Default Pack Properties, you can choose which tool properties from

the Tool Wheel affect the Objects you add to your Canvas. By default, your

Objects will appear as you created them when added again on Canvas. By

toggling the different options, you can decide whether the Object uses one

or more properties from your currently active tool in the Tool Wheel. Do

note that toggling the options will only affect new Objects in the pack,

unless you tap the Apply Properties button.

Toggling Brush Type on will use the active tool in the Tool Wheel when

adding an Object to the Canvas.

Toggling Size on will use the active tool's size in the Tool Wheel when

adding an Object to the Canvas.

Toggling Color on will use the active tool's color in the Tool Wheel when

adding an Object to the Canvas.

9. Tapping the Apply Properties button will apply the chosen Brush, Size and

Color property settings on all the existing Objects in the pack.

10. With the Live Share Link, you can share the Object Pack with other users.

Read more about Sharing Objects Packs below.

11. You can also Delete Pack to permanently delete your Object Pack. Please

note that this cannot be undone.

Editing Object Settings

As with the Object Pack Settings, you can also edit your individual Object's settings. You

can edit the Object name, change the brush property settings and add search tags for

your Object.
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1. To start editing your Object's settings, go to the Pack View of your Object

Pack, and Tap+Hold on the Object you want to edit.
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2. To edit the Object, tap the Edit option in the pop-up menu.

3. If you have an active Selection, you can also replace the current Object

with the currently active Selection, by tapping the Replace With Selection

option. Please note that this cannot be undone.

4. If you want to delete the Object, press the Delete option in the pop-up

menu. Please note that this cannot be undone.
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5. In the Object Settings, you will see all the options you can apply to your

Object. You can get back to the Object Pack View by tapping the Back to

Pack button.

6. You can move back and forth between the Objects in your current pack

with the < and > buttons.
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7. Here you can name your Object.

8. You can add tags to your Object. This will affect how the Object will appear

when using the search function in the Object Library.

9. In the Individual Object Properties, you can choose which tool properties

from the Tool Wheel affect the object when you add it to your Canvas. By

default, your Object will appear as you created it when added again to the

Canvas. By toggling the different options, you can decide whether the

Object uses one or more properties from your currently active tool in the

Tool Wheel. Do note that toggling the options for an Object will only affect

this particular Object in the pack.

Toggling Brush Type on will use the active tool in the Tool Wheel when

adding the Object to the Canvas.

Toggling Size on will use the active tool's size in the Tool Wheel when

adding the Object to the Canvas.

Toggling Color on will use the active tool's color in the Tool Wheel when

adding the Object to the Canvas.

10. You can also Delete Object to permanently delete the Object. Please note

that this cannot be undone.

Sharing Object Packs, iOS only

If you'd like to share an Object pack with a colleague who has also subscribed to team-

sharing, go to the My Objects tab in the Objects menu. Tap+hold your Object pack to

select it, and touch Share.
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You'll be given a Direct Link that you can copy to your device's Clipboard, or just tap

Share in the upper right corner. Choose your destination and share the link.

When you or your colleague touch a link and open it in your app, it will ask if you'd like

to accept the Object pack. Accept it, then find the pack in your My Objects tab in the

Import menu.
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Troubleshooting. If for some reason you can't find the Object pack, log out of your

account via your profile icon and log back in, and the Object pack will appear. You can

also Ask Us Anything in app via the question mark on the status bar.

Things you should know about sharing Object packs:

Sharing is public, but is only discoverable by people who have the link.

Your Object pack is read-only to everyone except you. You are the only one

who can add, rename or remove Objects or rename the pack.

Any changes you make will instantly appear on anyone's device that has

subscribed, with whom you've shared your link.

Any Object pack that you have created, you can share. Content shared is

subject to our Terms of Services.

Anyone can unsubscribe from your share at any time.

We think you'll find a substantial and enjoyable amount of value in creating and sharing

your object packs - time savers plus fun for everyone.

We have a fully illustrated tutorial on Objects here if you'd like more help: Using the

Object Library and Make Your Own Objects.

Pexels

Pexels provides free, high-resolution stock images for use in your drawings. Read and

accept Pexels' Terms of Service to search from thousands of reference images.

https://concepts.app/en/how-to-use-the-object-library/
https://concepts.app/en/how-to-use-the-object-library/
https://www.pexels.com/terms-of-service/
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1. To start using Pexels, scroll to the bottom of the Object Library or tap the

Pexels tag at the top of the Library window.

2. Ensure you understand the terms of service before enabling Pexels.

3. Accept Pexels' terms and conditions by toggling the switch.
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4. Once you have accepted Pexel's terms and conditions, you can tap Enable

Pexels.
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5. Once you have enabled Pexels, you will see the featured feed. You can tap

the preview to see more featured images.

6. To see images from a specific topic, use the Search function at the top of

the window.

7. Use the search function to narrow the results.

8. To search only for Pexels images, tap the Pexels filter at the top of the

Library panel.
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9. Tap or drag the image you want to use to add it on the Canvas.

10. To see more results, tap the Show More text at the bottom of the Pexels

section.

11. Once you've tapped Show More, you will see the full list of search results.

Concepts loads only a portion of the images, but you can scroll down to

load more.
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Import

Import

QUICK SUMMARY

1. Tap the Import icon to bring images to your drawing.

2. Drag & drop images directly onto your canvas from other apps.

3. Copy strokes to your clipboard to duplicate them to another drawing.

Concepts can import JPG, PNG, PSD, PDF and the native .concept or .concepts files.

Images are imported to scale onto your canvas. You can import files in Concepts in

multiple ways: via drag & drop, the Import menu, or through your device's clipboard.

You can also export selections in Concepts to import into other drawings.

Importing in Concepts

1. Tap the Import Icon in the Status Bar to open the Import Menu.
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2. The Import Menu will open and show several options.

Photos. Import photos from your device's photo library. (Not available on

Windows)

Files. Import files from your file system.

Paste from Clipboard. Paste any files supported by Concepts

Take a Picture. Take and import a Photo using the device's built-in

Camera.

Recently Imported. View the recently imported items for quick access.

(iOS only)



Concepts Manual Import

275

3. Your imported image will be selected, allowing you to position or resize it

before placing. Tap outside the bounding box to deselect the image.

4. If your layers are set to Automatic, Concepts will create an image layer at

the bottom of the layer list. If your layers are set to Manual, the image will

import to your active layer.

Importing a .concept or .concepts File

You can import the native .concept and .concepts files just like any other compatible

files; open them from the Import menu or drag them into your Gallery.

Currently, iOS uses a different native file format than Windows and Android platforms. At

the moment, iOS can only open .concept files and Windows and Android can only open

.concepts files. We are working on bringing these two file formats together.

Importing with Drag & Drop



Concepts Manual Import

276

You can use drag & drop from any supported app to import images to your canvas.

Select images directly from your Photos app, browser, or any other supported app, and

drag them into Concepts.

1. Tap+hold the image in your preferred app.
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2. You can select multiple images to drag into Concepts.

3. When you have selected the images to import, bring up the app selection

by swiping up (this may depend on your operating system).

4. Choose Concepts.
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5. Drop the images into Concepts.
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6. Your imported image will be selected, allowing you to position or resize it

before placing. Tap outside the bounding box to deselect the image.

7. If your layers are set to Automatic, Concepts will create an Image layer at

the bottom of the layer list. If your layers are set to Manual, the image will

import to the active layer.

Importing via Clipboard

You can use your device's clipboard to store images, objects, or selections. You can

also copy images from your file manager or web browser to the clipboard.
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1. When adding strokes to clipboard in Concepts, first select the item you

want to import.

2. Tap the Paperclip icon in the Selection menu.
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3. You can also copy from another supported app to your clipboard.
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4. Open the Import menu by tapping the Import Icon.

5. Tap the Paste from Clipboard. You can also use the keyboard shortcut Ctrl

+ V to import from the clipboard.
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6. You can also import the content of your clipboard with a tap+hold gesture

on your canvas, then tapping the Paste icon.
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7. Your imported item will be selected, allowing you to position or resize it

before placing. Tap outside the bounding box to deselect the item.

Importing a PDF

For importing PDFs, see PDF.
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Export

Export

QUICK SUMMARY

1. Tap the Export icon to share your drawing in other formats.

2. Choose the export Region and Resolution to suit your needs.

3. Export a Selection when you only want to share a specific part of your

drawing.
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Exporting in Concepts

1. When you are ready to export your drawing, tap the Export icon in the

status bar to open the Export Menu.

2. Choose the Format you want to export to. Please note that due to

Concepts' unique Vector-raster hybrid engine, strokes might look different

when exported in a vector format. For vector exports, we suggest using the

Fixed Width or the Wire brush. Read more about the Exporting Formats.



Concepts Manual Export

287

JPG. A lossy raster format.

PNG. A lossless raster format.

SVG. A simplified vector format.

DXF. A vector format usable in CAD software.

.concept / .concepts. Concepts' native format.

PSD. Photoshop's high-resolution raster format with layer support.

PDF, Flattened. A high-resolution raster format.

PDF, Vector Paths. A vector PDF format.

3. Choose the Region you want to export.

Screenshot exports the area currently visible on the screen.

Entire Drawing exports all the lines in the whole drawing into a single file.

This can lead to large file sizes.

Artboard confines the export to your Artboard's boundaries, for

example, A3. You will need to set up an Artboard in the Settings for this

option to be visible.

PDF Bounds uses the area of the imported PDFs in the document as the

export area.

Selection export option is the only available option if you have an active

Selection. This will only export the strokes you have selected as a single

image.

4. Choose additional Options for your export.

Transparent. The background will be exported as transparent instead of

using your background texture or color. This option is not available in

JPG.

Paper. Your background paper will be included in the export.
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Grid. Your grid will be included in the export. Note that you will need to

activate the grid in the Precision menu for this option to be available.

Use Filters. An SVG export option. This will add the texture images of

brushes and the background into the export.

Wireframe. A DXF export option. This will export the lines as wireframes.

All Layers. A PSD export option. This includes all Layers, even hidden

ones, in your export.

Visible Layers. A PSD export option. This includes only visible Layers in

your export.

Original Pages. If you have selected PDF Bounds as your region, you

can use this option to include all the pages of a multi-page document.

5. With Output Details, you can control the size of your export.

When exporting using the Entire Drawing or Artboard region, you can

choose from device-specific ppi settings: 72, 150, 300, and 600 ppi. The

larger the ppi, the higher the image quality and file size.

When exporting a Screenshot or an Artboard measured in pixels, you

can choose to export at 100%, 200%, or 400%.

6. Once you're happy with your settings, tap Export.

Exporting with Drag & Drop

Concepts supports iOS' and Android's drag & drop capabilities. On iOS, you can drag &

drop Selections, images, text, and colors both into and out of Concepts with supported

apps. On Android, you can drag & drop Selections to supported apps. Images are

exported as transparent PNGs.
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1. Toggle to enable Drag & drop active selections in Settings > Interactions

menu.
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2. Using the Lasso or Item Picker, select what you would like to copy to

another app.
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3. Tap+hold on your Selection. It will pop out from the screen slightly to

indicate it is being dragged & dropped.

4. Start dragging your Selection. Swipe upward on the tab with another finger

to open another app and choose your destination app.
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5. Drag in your Selection. You should see an indication where the Selection

can be added.

This feature is not currently available on Windows. Read how to drag & drop selections

into Concepts in the import section.

Exporting via Clipboard

You can attach Selections, images, text and colors (iOS) to your device's clipboard, and

paste them into email, text, supported document editors and other apps.
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1. To copy a selection to your clipboard, start by selecting your drawing,

selection, or Object.

2. Tap the Paperclip icon in the Selection popup to add it to your clipboard.
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3. Open your app of choice and Paste your item.

For more tips on exporting, read Tips for Exporting Your Designs.

Exporting File Formats

JPG

A standard, lossy compression format is best for quick emails or low-resolution

screenshots. You can choose from several different resolutions.

PNG

A standard, lossless compression format for images viewable on nearly any device. PNG

format also supports transparency. You can choose from several different resolutions.

SVG

A standard format for simplified vector paths that include point data and colors, but it is

limited to a single line weight per stroke and very rough texture support.

SVG formats are different and proprietary, so you can expect to see inconsistencies

between vector stroke appearances in Concepts versus other vector apps.

Concepts' specialized textured strokes are not supported across other vector apps. If

you intend to export your work to other vector editors, use the Fixed Width or Wire

brush for drawing. Hard Mask and Soft Mask strokes will display as white lines, so use

the Slice (eraser) tool to trim your line work.

If exporting for Adobe Illustrator, make sure to uncheck Filters in the options.

DXF

DXF (R14) is a CAD format developed by Autodesk that includes vector paths and basic

color representation, useful for CAD models and laser/waterjet cutting.

Use the Fixed Width or Wire brush in Concepts for drawing.

https://concepts.app/en/tutorials/tips-exporting-your-designs/
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Hard Mask and Soft Mask strokes will display as white lines, so use the Slice (eraser) tool

to edit line work intended for DXF export.

.concept and .concepts

The Concepts native file format. This format is best if you want to continue editing the file

on another device or share your drawing for collaboration. On Windows, you will need to

select Save As to export the drawing as a native .concepts file type.

Currently, iOS uses a different native file format than Windows and Android platforms.

Currently, iOS can only open .concept files, and Windows and Android can only open

.concepts files. We are working on bringing these two file formats together.

You can also export as .concept or .concepts if you want to back up your drawings to

the cloud. Read our illustrated tutorial on backing up your drawings.

PSD

Adobe's Photoshop format supports multiple layers in a high-resolution raster format.

PDF (Adobe PDF, Flattened)

PDF is an industry standard, optimized for displaying documents on any screen or

platform. This is the raster version that maintains look and feel but loses vector path data.

Files can be large if exported at high resolutions.

PDF (Adobe PDF, Vector Paths)

PDF is an industry standard, optimized for displaying documents on any screen or

platform. This is the vector version that supports basic paths but loses the textures of

your brushes.

https://concepts.app/en/tutorials/backing-your-drawings-icloud?utm_source=helpfeed&utm_medium=ios_app
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PDF

PDF

QUICK SUMMARY

1. Import documents, annotate and export for fast workflows.

2. Import PDF pages scaled to the correct size.

3. Export to PDF so your designs will look sharp on every display.

PDF (Portable Document Format) is a standardized file format that allows graphic data

like fonts, images and layouts to be converted into a flattened document for viewing on

any screen and any platform.

Concepts allows you to create, import, mark up, rearrange, substitute and export PDF

pages. PDF Import/Export is available in the Pro Store as part of the Essentials or an

Everything subscription.

Importing a Single-page PDF

1. Tap the Import icon in the Gallery or in the Status Bar when in a drawing and

choose the file you want to import.
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2. A single-page PDF will import just like an image onto the canvas.

3. When imported on canvas, your PDF will be selected, and you can position

it exactly as you would an image, object or other selection.

4. Your PDF will import to scale onto your canvas. Concepts respects the

original size; for example, an A3-sized PDF will appear as 297 x 420

millimeters on your canvas. If you enable measurements, the

measurements displayed in Concepts will match the imported document.

Importing a Multi-page PDF

1. Tap the Import icon in the Gallery or in the Status Bar when in a drawing.



Concepts Manual PDF

298

2. With a multi-page PDF, you will see a scrollable menu at the side of the

screen.

3. You can drag or tap to add the pages to your canvas.

4. When imported on canvas, your PDF will be selected, and you can position

it exactly as you would an image, object or other selection.

5. Your PDF will import to scale onto your canvas. Concepts respects the

original size; for example, an A3-sized PDF will appear as 297 x 420

millimeters on your canvas. If you enable measurements, the

measurements displayed in Concepts will match the imported document.

6. Swipe the PDF menu off the edge of the screen to hide it. You can bring it

back from the selection menu. (See step 2 on the Selection menu image

below.)
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Selection Menu

When a PDF page is selected, the Selection menu has a few additional options.

1. Clipboard: Copies the PDF page to the clipboard.

2. Multi-page: Opens the multi-page view. This is only visible for PDFs with

more than one page.

3. Alpha On/Alpha Off: Enables or disables the imported page's alpha channel.

If the alpha channel is disabled, transparent sections will show as white.

4. Duplicate: Creates a duplicate of your selected page.

5. Group/Ungroup: Collects all items inside your selection into a single group.

You can then select the entire object by selecting a single stroke inside the

group. You can ungroup the selection by tapping the button again when the

group is selected.

6. Lock/Unlock: Locks your selection from subsequent selections and

adjustments. You can access the locked item again by allowing selection of

locked items in the Selection options. You can unlock the selection by

tapping the button again when the locked item is selected.

7. Trashcan: Deletes the selected page.

8. Flip Horizontally: Mirrors the selection on the horizontal axis.

9. Flip Vertically: Mirrors the selection on the vertical axis.
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Exporting a PDF

1. Concepts reads your pages from top to bottom and from left to right. To

rearrange pages in your PDF, drag them onto the screen into the desired

order, then export your PDF.

2. When you are ready to export your PDF, tap the Export icon in the status

bar to open the Export Menu.
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3. Format

PDF (Adobe PDF, Flattened): This option is the standard PDF export that

flattens your work into a high-resolution document.

PDF (Adobe PDF, Vector Paths): This allows you to export Concepts

vector paths to PDF for use in editors that allow you to work with vector

PDFs, such as Adobe Illustrator. Warning: The resulting PDF will not look

exactly the same as your Concepts sketch. Any lines with varying width

or texture will appear as simple, non-textured lines. If you want to export

your file for use in other vector editors, use the Fixed Width or Wire

brush for drawing and the Slice (eraser) tool for trimming.
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4. Region

From Region, you can choose the area included in the PDF.

Screenshot: Exports the area currently visible on the screen into a single

PDF page.

Entire Drawing: Exports all the lines in the whole drawing into a single

PDF page. This can lead to large file sizes.

Artboard: Confines the export to your artboard's boundaries and exports

it as a single PDF page. You will need to set up an artboard for this option

to be visible.

PDF Bounds: Uses the area of the imported PDFs in the document as the

export area. If you import more than one page of a PDF, it will result in a

multi-page PDF document.

Selection: This export option is only available if you have an active

selection. It will only export the strokes you have selected as a single

PDF page, which is useful for small illustrations and email attachments.

5. Options

You can change the export Options of your PDF to include what you'll need in your

file.

Transparent: The background will be exported as transparent instead of

using your background texture or color.

Paper: Your background paper will be included in the export.

Grid: Your grid will be included in the export. Note that you will need to

activate the grid in the Precision menu for this option to be available.

Original Pages: If you have selected PDF Bounds as your region, you

can use this option to include all pages of a multi-page document even if

you have imported only one page (useful for signing documents, for

example).
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6. Output Details

In Output Details you can control and see the size of your export.

When exporting using the Entire Drawing or Artboard region, you can

choose from device-specific PPI settings: 72, 150, 300, and 600 PPI. The

larger the PPI, the higher the image quality and file size.

When exporting a screenshot or an artboard measured in pixels, you

can choose to export at 100%, 200% or 400%.

7. Export

Once you've chosen your settings, tap the Export button.
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Settings

Settings

QUICK SUMMARY

1. Tap the Settings icon in the status bar to find Settings.

2. Workspace settings control your background, grid and artboard.

3. Interaction settings control your input preferences, such as stylus and finger.

In Settings, you can customize your workspace and how you interact with your canvas.

Under the Workspace tab you can configure your canvas experience. Under the

Interactions tab, you can customize how you operate with the app.

Workspace

In the Workspace tab, you can configure your canvas experience. You can set the

background color, grid, artboard and scale.

Canvas

Background

Concepts has ten background options, including textured paper types, transparent,

blueprint and darkprint. You can also create a custom color background.
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Grid Type

There are several grid options to choose from: Dot grid, Graph Paper, Lined Paper,

Isometric, Triangle and 1, 2, 3 point Perspective Grids. To learn more about grids and

how to set a custom grid, see Grid.

Artboard

Artboard Size

Concepts has an Infinite Canvas, but you can set a specific size Artboard to help with

composition and framing. You can use one of the presets or create a custom-sized

Artboard. If you have set up an Artboard, you can use it when exporting your drawing.

1. Tap on the size to enter values for a custom-sized Artboard.

2. Tap one of the presets under the Artboard size.

3. Tap the three dots to see more presets.
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If you don't want your artboard to be movable, go to Interactions -> Stylus -> Enable

artboard drag and toggle the option off.

Measurements

Drawing Scale

Set the scale for your drawing in this section.

1. Select a scale from one of the shortcuts.

2. Tap on the value fields to enter a custom scale.

Read more about setting Scale for your project.
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Display Units

You can choose a unit for all measurements.

Digital: Pixels, Points

Metric: Automatic scale, Millimeters, Centimeters, Meters, Kilometers

Imperial: Automatic scale, Inches, Feet, Yards, Miles

Choosing Auto-Scale will automatically resize your units as you draw when increasing or

decreasing lengths (for example, mm > cm > m).
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Display Format & Precision

Choose a notation and precision level for your measurements. The level of precision

available depends on your chosen unit of measurement.

Underneath the format and precision, there are additional toggles.

1. Show stroke length on the right side when drawing moves the precision

labels to the other side of the stroke. This is useful for left-handed people

to better see the measurement label while drawing.

2. Show scale in the status bar for selections allows you to view and edit the

percentage of your Selection when scaling.
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Tool Setup

Interface

You can choose between the Tool Wheel or the Tool Bar. This determines how your tools

are laid out on the Canvas.

Performance

Toggle off the Enable Low-Latency Mode if you are experiencing problems with

performance (Android only).

Interaction
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Under the Interaction tab, you can configure how you operate Concepts with gestures

and styli.Under the Interaction tab, you can configure how you operate Concepts with

gestures and styli.

External Displays (Only on iOS)

Presentation Mode

You can easily present in Concepts by connecting your device to an external display via a

cable or AirPlay. AirPlay supports connecting to an Apple TV, video conferencing apps

like Zoom, and macOS AirPlay apps like Reflector.

1. Mirror Everything: You can choose to present your Canvas without menus

or mirror the full Canvas with controls.

2. Show Touches: You can choose whether to share your stylus or finger

touches with the audience.



Concepts Manual Settings

311

Connecting Your iPad to an External Display

Connect your iPad to an external display using an HDMI cable.

Or

1. Connect your iPad using AirPlay. Open the command center on your iPad

and tap Screen Mirroring.
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2. Select the device from the list. A code will appear on the secondary screen;

enter that code into your iPad to pair the devices. Your iPad will remember

the device for instant mirroring in the future. Once you return to the main

screen, you will see your iPad's contents displayed on the external display.

Open Concepts and enter a Drawing.

Presenting in the App

1. Once connected, a Presentation mode icon will appear in the Status Bar at

the top of your Concepts Canvas. Tap this icon to find your toggles.

2. If the external display's aspect ratio differs from your device's screen, you

will see two horizontal boundaries. These boundaries represent what is

shown on the external screen. You can sketch, zoom, pan, select, adjust

and perform all other normal actions in Concepts.



Concepts Manual Settings

314

Keyboard & Mouse

Keyboard Shortcuts

The Keyboard & Mouse section allows you to enable or disable keyboard shortcuts and

customize them.

1. Tap Edit Shortcuts to see and edit the full list of keyboard shortcuts.

2. You can also Enable/Disable Keyboard Shortcuts.

3. Tap the typing field to edit a shortcut.
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4. Type the Keyboard Shortcut you want to use. You can use modifier keys

such as Ctrl, Alt and Shift with alphanumeric characters to edit the

shortcuts.

5. To cancel editing, tap the X button.

6. To restore a shortcut to its default, activate the shortcut field and tap the

arrow next to the typing field.

7. To restore all keyboard shortcuts to their defaults, scroll down and tap

Reset Shortcuts.

For users without touch-enabled devices, keyboard shortcuts provide easy access to

Pan, Zoom, and Rotation modes. Learn more about Pan, Rotate and Zoom modes in the

navigation section.



Concepts Manual Settings

316

Touch Input

In the Touch Input section, you can choose how you interact with the app.

Finger Action

If you have a supported stylus, you can set your finger to perform actions other than

drawing, such as: Do Nothing, Use Active Tool, Pan Canvas, Select, Nudge, Slice, and

Configured Tool.

Two Fingers

The default setting for two fingers is canvas rotation and zoom. If you want your canvas

to maintain its angle and zoom at all times, you can disable canvas rotation and zoom.

1. Disable the two-finger gesture for Canvas Rotation.

2. Disable the two-finger gesture for Canvas Zoom.
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You can tap+hold on the degree or zoom value in the upper right corner of the status

bar to enter the rotation via keyboard. You can also use the canvas rotation keyboard

shortcut or the rotation tool.

Tap + Hold

You can set the action and timing for the tap+hold gesture according to your

preferences.

1. Choose the action you want to use for the tap+hold gesture.

2. Edit the activation time of the action by moving the slider.

3. Highlight selection subdues other strokes on your canvas when a selection

is active.

4. By activating Drag & Drop active selections you can move selected strokes

as PNGs to other supported applications.
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Two-finger tap, three-finger tap and four-finger tap

There are several options to choose from for each gesture: do nothing, undo, redo,

select last item, show Layers, show Color Wheel, Tool Setup, show Objects, toggle Shape

Guide, toggle Interface, toggle canvas rotation, toggle canvas zoom, or select all.

Draw & Hold

Shape recognition allows you to quickly turn rough strokes into perfect shapes.

1. You can enable or disable Shape Recognition by toggling the switch.

2. You can edit the Activation Time by adjusting the slider.

Start by drawing a shape with one to four strokes. Then hold at the end of the final stroke

to detect a shape. When the shape has been detected, you can scale and rotate it by

moving your stylus without lifting it from the screen. Supported shapes include straight

and curved lines, arrows, triangles, squares, rectangles, circles and ellipses.
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Left or Right Handed? (Only on iOS)

You can choose your handedness. This determines your default interface layout. This

will also change the side of the measurement labels.
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Stylus

Under Stylus, you can configure settings specific to your stylus. If you are using a

supported stylus, you can adjust and enable the pressure response and enable the tilt.

The settings might differ depending on your platform.

Pressure Response. You can use the Pressure Response sliders to restrict

the pressure response.

Pressure. Enable or disable pressure when using a stylus.

Tilt. Enable or disable tilt recognition.

Tap & Hold. Enable or disable the Tap+Hold feature when using a stylus.
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Enable Artboard Drag. Enable or disable the ability to drag the Artboard with

a stylus (Windows and Android only).

Barrel Roll (Apple Pencil Pro). Enable or disable stamp rotation (iOS only).

Hover Brush Previews (M2+). Enable or disable showing brush stamp

previews (iOS only).

Shortcut Buttons

The shortcut buttons or the squeeze action (Apple Pencil Pro) on supported styli, or the

right mouse button, can be configured as well.

Eraser

If you use a stylus with a dedicated eraser end, you can set the eraser action. The chosen

settings will also be applied for the keyboard shortcut eraser E.
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Concepts for Business

Concepts for Business

Concepts strikes an ideal balance between the expressiveness of hand drawing and the

precision of light-CAD. Use real-world measurements, directly mark up PDFs with

sketches and notes, and drive rapid iteration. Concepts gives your team all the tools they

need to think and communicate quickly.

Who is Concepts for Business for?

Teams of all sizes use Concepts to iterate on design ideas and share work with clients

instantaneously. Teams that commonly use Concepts:

Architects

Engineers
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Industrial Designers

Landscape Designers

Features

Your team membership means you have access to all of Concepts' Pro features. These

are features and tools that allow you to be even more efficient, like advanced Selection

and Editing tools, Custom Brushes, unlimited Objects and more!

Click the link below to read an overview of Concepts Pro features and how to use them.

Learn how to use all of Concepts' Pro features.

Setting Up Your Team & Billing

Team admins can give teammates instant access to Concepts' Everything subscription on

any platform without complex installation procedures or setup.

Pricing varies by region — you'll find the most accurate pricing when you create a team

and choose a plan. Still need to set up your team in Concepts? We’ve created a step-by-

step guide to make creating your first team simple.

Read the Guide and create your team now.

Need invoice-based billing? Require security audits or custom configurations? Or are you

looking for dedicated training? Let's talk about enterprise licensing.

Contact Sales

https://concepts.app/en/how-to-setup-your-concepts-team/
https://concepts.app/en/account/sign-in/
mailto:sales@concepts.app


Concepts Manual Concepts for Business

324

How to Deploy Concepts

The most common issue we hear is that IT teams are used to deploying software to

Windows and don't have experience with iOS or Android devices.

For iOS, Apple has detailed guides on how to deploy to their devices.

Google has documentation on how to deploy to Android devices. And specifically for

Samsung's tablets, they have additional solutions that you can learn more about.

Alternatively, if Windows is the only path there are some great tablets available from

Microsoft too.

Hardware Recommendations

If you're still shopping for hardware and would like our recommendations, check out our

hardware guide here.

https://support.apple.com/guide/deployment/welcome/web
https://www.android.com/enterprise/enrollment/
https://www.samsungknox.com/en/solutions/it-solutions/knox-mobile-enrollment
https://www.microsoft.com/surface
https://concepts.app/en/concepts-hardware-guide
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Syncing Your Work Across Devices

Your team's Concepts drawings are stored locally on their devices. If you'd like all of

your team's work backed up or shared between other devices, you might want to set up

cloud storage. Depending on the platform you are using, Concepts integrates with a

variety of cloud services that support syncing and backup.

Managing your Drawings

How to use iCloud Sync (iOS)

How to Sync drawings on Windows to your cloud of choice (Windows)

How to use FolderSync and Google Drive to Sync Your Drawings (Android)

How to use DropSync and Dropbox to Sync Your Drawings (Android)

How to use Syncthing to Sync Your Drawings (Android)

Where to Download Concepts

Concepts is available for download securely to your team's devices with automatic

updates from any of the following stores: Apple App Store, Microsoft Store, Google Play

Store, and Samsung Galaxy Store.

Direct Download

If your IT department manages the software that is installed on your Windows devices

then they may need to download an installer for Concepts. We offer a direct download

which they can use to deploy Concepts. Note, that this version will not auto-update, your

IT team will need to download and deploy updates manually. Once installed, your

teammates sign in to their account and they'll have access to all the Pro features.

Download Concepts for Windows (Teams Edition)

https://concepts.app/en/how-to-use-icloud/
https://tophatch.helpshift.com/hc/faq/253-how-do-i-sync-drawings-across-devices-on-windows/
https://concepts.app/en/how-to-use-foldersync-and-google-drive-to-sync-your-drawings/
https://concepts.app/en/how-to-use-dropsync-and-dropbox-to-sync-your-drawings/
https://concepts.app/en/how-to-use-syncthing-to-sync-your-drawings/
https://apps.apple.com/fi/app/concepts/id560586497
https://apps.microsoft.com/detail/9ngqm8fph9wq
https://play.google.com/store/apps/details?id=com.tophatch.concepts
https://play.google.com/store/apps/details?id=com.tophatch.concepts
https://galaxystore.samsung.com/detail/com.tophatch.concepts.galaxyapps
https://cdn.tophatch.com/downloads/windows/concepts_win_standalone_installer.msixbundle
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Additional Help

If you still can't find what you're after or have a specific question, email us at

sales@concepts.app

mailto:sales@concepts.app
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The Pro Shop

The Pro Shop

Basic

Concepts comes as a free, solid sketching app when you download it from the App

Store, Google Play Store or Microsoft Store. You can enjoy it this way for as long as

you'd like. We feel like everyone deserves a solid sketching app whether they can buy

one or not, so enjoy our basic tools, responsive feel, colors, customizable layout, infinite

canvas and JPG exports with this free package.
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Subscribe to Get Everything

Subscription unlocks everything in the app. This includes Selection, PDF, every export

type, every object library, Make Your Own Objects, the beautiful custom brush libraries,

and all updates going forward as we release them. On iOS you can securely share the

assets you create with your team members and friends, your favorite object libraries,

custom brushes and color palettes.

With a subscription, you can try the app free for 7 days to decide if it’s a good fit for

your creative style. You will not be charged until the 7 day period is over. If you decide to

cancel, just head over to your payment settings in your iTunes, Google Play or Microsoft

Store account before the trial ends and cancel the subscription.

Your subscription allows us to build Concepts into the ultimate, flexible tool for visual

thinking, illustration and design. We update regularly with great features requested

directly by you because of your amazing support. Thank you so much.
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Pick Your Favorite Features

Pick what you need from the A-la-carte bar. The Essentials gives you a great professional

toolkit to sketch with. You might decide you need PDF Import / Export, an object pack or

two, or some additional artistic brushes. Feel free to choose just what helps your work

along.
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The Essentials

We created this toolset especially for professionals, previously known as the Pro Pack.

You get a long list of features, including our powerful ability to select, move and adjust

your vectors, an editor to create and customize your own brushes (iOS only), import and

export PDFs, the Basic Shapes object library, and most of our high-res and vector

exports. Please note that Essentials is a platform specific purchase.

Objects

Our royalty-free, customizable vector objects are a win for making your design-work

efficient yet elegant. Buy what you need to speed up your workflow.

Brushes

In the Brush Market, we've crafted some beautiful brushes that add instant artistic

elements to your drawings like pastels, chalk, sprays, pens and background textures.

Every brush is fully adjustable like all of our vector-based tools, and can be duplicated

and edited using the Brush Editor. Purchase these brush packs individually, or get

everything with subscription. You can read more about these brushes and how to use and

edit them in Brush Market Brushes.
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Thanks for all the support. You make a world of difference to us - in fact, you are our

entire world. We appreciate you.

Happy creating,

The Concepts Team @ TopHatch


